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1 Per Iniziare

Introduzione

Portrait Professional è il modo più facile e veloce per ritoccare i tuoi ritratti. Usando solo 5 semplici fasi ti
permetterà in pochi minuti di ottenere risultati professionali.

Portrait Professional lavora in modo completamente differente dai normali programmi di ritocco fotografico
utilizzati di solito dai professionisti. Infatti, essendo stato sottoposto a centinaia di esempi di bellezza umana,
Portrait Professional ti permette di migliorare le tue foto tanto quanto lo desideri semplicemente muovendo gli
slider. 

Grazie all'innata cognizione di bellezza inserita da principio nel software, chiunque può raggiungere la più alta
qualità di ritocco fotografico in pochi minuti.

Portrait Professional è disponibile in tre edizioni: Standard, Studio e Studio64. Le tre  versioni sono illustrate in
questo manuale.

Portrait Professional è disponibile per  Windows e Mac. Questo manuale è per le versioni Windows.

Per Iniziare

Guarda la Guida Avvio Rapido  per avere una prima visione d'insieme su come usare Portrait Professional.

La Guida Passo dopo Passo  ti fornirà maggiori e più dettagliate informazioni su ogni fase.

Se hai bisogno di ulteriore aiuto, visita il sito www.portraitprofessional.com/support, dove potrai vedere le più
aggiornate FAQ ed accedere al nostro sistema di richiesta di biglietto di supporto. Il sistema ti permetterà di
inviare richieste al nostro staff di assistenza.

1.1 Guida di Avvio Rapido

Portrait Professional ti guiderà  dettagliatamente attraverso ogni fase ma nel frattempo inizia col dare
un'occhiata alla guida di avvio rapido posta qui sotto per familiarizzare con le diverse fasi.

Fase 1 - Seleziona l'immagine da migliorare

Quando apri Portrait Professional ti apparirà la schermata di benvenuto.

Per modificare la tua immagine clicca sul pulsante Apri, o seleziona Apri... dal menu File. Questo aprirà la
finestra di dialogo 'Apri File' dove potrai scegliere l'immagine da caricare.

Se non hai un'immagine a portata di mano, puoi cliccare su una delle immagini di esempio.

Portrait Professional caricherà l'immagine e la visualizzerà nella finestra di lavoro principale.

Maggiori informazioni sulla Fase 1.

Fase 2 - Seleziona il genere di viso che vuoi migliorare

Clicca sul pulsante Maschile o Femminile per permettere a Portrait Professional di individuare se il viso scelto
è un viso di donna o quello di un uomo.

Se l'immagine non è orientata in modo corretto verso l'alto, clicca sul pulsante di orientamento per ruotarla
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nella giusta posizione. I pulsanti di orientamento sono alla base del pannello dei controlli.

Maggiori informazioni sulla Fase 2.

Fase 3 - Clicca sui 5 punti chiave del viso

Clicca su ognuno dei seguenti punti del viso nella foto:

Dopo che hai cliccato su un punto, Portrait Professional passerà automaticamente a quello successivo.

Un'immagine di esempio ti verrà mostrata per aiutarti a capire dove posizionare ogni punto.

Puoi regolare la posizione dei punti che hai già disposto semplicemente cliccando sul punto e trascinandolo
di nuovo.

Maggiori informazioni sulla Fase 3.

Fase 4 -  Regola i contorni dei lineamenti e del viso

Portrait Professional ti guiderà  attraverso ogni singolo tratto del viso in modo che tu possa verificare e, in caso
di necessità, regolare il posizionamento del contorno di ogni lineamento.

I punti importanti sono quelli attorno agli occhi e alla bocca. Gli altri punti non necessitano di un
posizionamento accurato. In questo modo non dovrai spendere più di qualche secondo in questa fase. In
genere, meno aggiustamenti fai, migliori saranno i risultati.
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Per muovere una linea di contorno, clicca col mouse su uno dei quadrati (blu o bianchi) al suo interno e
trascinalo. Per un risultato ottimale, cerca di spostare le linee di contorno il meno possibile.

Clicca Avanti (o premi la barra di spazio) per procedere alla fase successiva.

Maggiori informazioni sulla Fase 4.

Fase 5 - Visualizza l'immagine migliorata e definisci nel dettaglio i risultati

Portrait Professional inizierà adesso il processo automatico di miglioramento dell'immagine, che dovrebbe
richiedere solo qualche secondo (tutto dipende dalla potenza del tuo PC). Una volta completata l'elaborazione
vedrai la foto originale sulla sinistra dello schermo e quella migliorata sulla destra (puoi cambiare questa
impostazione di impaginazione selezionando le etichette Visualizza Prima e Dopo e Visualizza Solo Dopo,
che trovi in alto a destra dell'immagine).

Tieni premuto il tasto INVIO per alternare l'immagine prima con quella dopo l'elaborazione e osservare così i
cambiamenti. 

Se sei soddisfatto già dopo questo primo miglioramento, hai completato il ritocco della tua prima immagine
con Portrait Professional. Ad ogni modo, puoi rifinire i miglioramenti con grande facilità e velocità usando i
controlli sulla destra dello schermo, e ottenere così qualsiasi risultato desideri, da un marcato ritocco glamour
a un'immagine di bellezza al naturale.

In qualsiasi momento puoi salvare l'immagine che hai migliorato selezionando Salva dal menu File in alto a
sinistra dello schermo.

Puoi anche salvare l'intero progetto selezionando "Salva Sessione" – operazione che ti permette di tornare al
progetto in un momento successivo, e continuarlo, senza passare di nuovo per le prime 4 Fasi.

A volte un posizionamento inaccurato dei punti potrebbe causare inestetismi, come una leggera distorsione
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del viso o delle labbra. Per rimediare, puoi tornare indietro in qualsiasi momento e regolare i punti
semplicemente cliccando sul pulsante Indietro in alto a sinistra del pannello di controllo.

Nel caso ci sia più di un viso nella foto, seleziona "Migliora Un Altro Viso In Questa Foto" dal menu File. Nota
che in questo modo sarai riportato alla fase iniziale del processo e non sarai in grado di salvare l'immagine
fino al nuovo raggiungimento della fase finale.

Maggiori informazioni sulla Fase 5 .

1.2 Consigli Utili per Migliori Risultati

Se hai intenzione di leggere solo un pagina in questo manuale, fai in modo che sia questa, in quanto ti
permetterà di ottenere i migliori risultati con Portrait Professional.

Non perdere troppo tempo a regolare il contorno

La fase di Regolazione del Contorno  non dovrebbe richiedere troppo tempo.

Non hai bisogno di posizionare alla perfezione ogni punto. In genere si ottengono perfino migliori risultati
quando non li si muove affatto.

Gli unici punti che hanno bisogno di essere posizionati nella giusta maniera sono quelli attorno agli occhi e
alla bocca. Per gli altri punti, se sono stati posizionati automaticamente in maniera grosso modo corretta,
resisti all'impulso di apportare minuziose modifiche.

Muovi i punti il meno possibile

In fase di Regolazione del Contorno , cerca di mettere i punti nella posizione corretta muovendoli il meno
possibile.

Es. Sposta i punti del viso sulla linea di perimetro ad essi più vicina ed evita di muoverli lungo il perimetro
stesso.

Questo è valido per tutti i punti, ad eccezione dei punti d'angolo. I punti sulle code degli occhi, o agli angoli
della bocca, devono essere posizionati in modo preciso.

Non eccedere con l'uso degli slider

Spesso, con minimi cambiamenti si ottengono i migliori risultati.

Sfrutta gli slider giusto il necessario per ottenere il risultato che desideri.

Se eccedi nell'uso, il risultato potrebbe sembrare innaturale o artefatto.

Non usare gli slider per correggere piccole imperfezioni

Puoi evitare l'esigenza di eccedere nell'uso degli slider usando lo strumento di Ritocco  per pulire via punti
e piccole macchie. Un metodo sicuramente migliore rispetto al sovrautilizzo degli slider, i cui effetti si
ripercuoterebbero su tutta l'immagine.

Accertati che l'area della pelle sia definita in modo corretto

Portrait Professional individua automaticamente l' 'area di pelle' nella tua immagine. Ad ogni modo, è
possibile talvolta regolare la selezione automatica dell'area per ottenere i migliori risultati.
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Usa gli strumenti Aumenta e Riduci  per intervenire su aree di pelle posizionate in maniera non adeguata.

1.3 Edizioni di Portrait Professional

Portrait Professional è disponibile in tre edizioni: Standard, Studio e Studio64. L'edizione Standard è studiata
per utilizzatori occasionali o fotografi amatori. L'edizione Studio  è destinata a veri appassionati o fotografi
professionisti.  Le versioni Studio e Studio64 hanno le stesse funzionalita'; la versione Studio, pero', è
un'applicazione a 32-bit mentre la versione Studio64 è un'applicazione a 64-bit. Cio' significa che la versione
Studio64 ha accesso a tutta la memoria del computer e quindi permette di lavorare con file di dimensioni
maggiori (fotografie molto grandi).

Questo manuale illustra entrambe le edizioni, con le funzioni disponibili solo per l'edizione Studio indicate in
questo modo:

Solo per Edizione Studio

Le principali differenze tra le due edizioni sono elencate qui sotto.

Supporto plugin Photoshop L'edizione Studio include un componente plug-in per
Photoshop, che permette di aprire un'immagine in Portrait
Professional Studio direttamente da Photoshop. Una volta
completato il miglioramento dell'immagine in Portrait
Professional, il risultato sarà automaticamente caricato su
Photoshop.

Lettura file immagini RAW , e file Adobe
DNG 

Solamente l'edizione Studio può leggere file di immagini
RAW e Adobe DNG.

Supporto 16 bit per campione di colore (48 bit
per pixel)

L'edizione Studio può lavorare con immagini contenenti 16
bit per campione di colore (48 bit per RGB pixel). L'edizione
Standard è limitata ad 8 bit per campione di colore (24 bit
per RGB pixel). Le immagini RAW contengono in genere più
di 8 bit per campione di colore - un numero di informazioni
aggiuntive che possono così essere conservate
dall'edizione Studio. 

Contrariamente all'edizione Standard, l'edizione Studio può
leggere e scrivere file TIFF contenenti 16 bit per campione di
colore.

Il formato JPEG non supporta 16 bit per campione di colore.
Di conseguenza se un'immagine contenente 16 bit per
campione viene salvata come file JPEG, questo verrà
automaticamente convertito ad 8 bit per campione di colore.

Supporto profilo di colore Le immagini possono contenere extra informazioni sullo
"spazio di colore" utilizzato dai valori di colore RGB. Se
queste informazioni vengono ignorate, i colori che appaiono
sullo schermo e quelli sui file salvati potrebbero non essere
corretti. Solamente la versione Studio legge, scrive e applica
queste informazioni di spazio di colore.

Flusso di lavoro perfezionato quando si L'edizione Studio ti permette di selezionare più file usando il
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migliorano immagini multiple file Sfoglia per creare una lista di file su cui lavorare. Questo
velocizza il tuo flusso di lavoro, poiché dopo aver migliorato
un'immagine potrai salvare il risultato e caricare la
successiva attraverso un singolo comando. 
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2 Guida Passo dopo Passo

Per migliorare un'immagine con Portrait Professional, devi seguire un semplice processo di 5 fasi.

Le seguenti sezioni descrivono ogni fase nel dettaglio.

Fase 1 - Apri Un'Immagine

Fase 2 - Seleziona Genere

Fase 3 - Posiziona Lineamenti Principali 

Fase 4 - Regola Contorno

Fase 5 - Migliora Immagine

2.1 Apri un'Immagine

La Schermata Iniziale di Portrait Professional

Quando apri Portrait Professional, il programma partirà con la schermata iniziale:

Aprire un'immagine

Per aprire un'immagine da migliorare, puoi:

Premere il pulsante Apri Immagine, oppure

Selezionare il comando Apri nel menù File .

14

16

18

21

21

26



Guida Passo dopo Passo 15

© 2011 Anthropics Technology Ltd.

Questo aprirà la finestra di dialogo Apri File:

Scorri fino al file che hai intenzione di  migliorare e premi il pulsante Apri.

In alternativa, clicca su uno degli esempi se vuoi provare l'applicazione e non hai nessuna immagine da
caricare a portata di mano.

2.2 Seleziona Genere

Selezione genere

Portrait Professional ha bisogno di conoscere le caratteristiche del viso da migliorare.Questo perché alcuni
miglioramenti danno i migliori risultati quando si conosce il genere del viso. 

Premi il pulsante Femminile se il viso è femminile (abbreviazione tastiera: f).

Premi il pulsante Maschile se il viso è maschile (abbreviazione tastiera: m).

Portrait Professional passerà automaticamente alla fase successiva una volta che hai selezionato il genere.
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Regolazione orientamento immagine

Se l'immagine non è correttamente orientata verso l'alto, clicca su uno dei pulsanti alla base del pannello di
controllo. Questo ruoterà l'immagine nella posizione mostrata dalle frecce. 

Nota che devi cambiare l'orientamento prima di selezionare il genere, in quanto una volta selezionato, Portrait
Professional passerà automaticamente alla fase successiva.

2.3 Localizza le Caratteristiche Principali

Dopo aver aperto un'immagine e selezionato il genere, la fase successiva consiste nel posizionamento delle
5 parti chiave del viso.
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Le 5 parti chiave sono:

 

Posizionamento punti chiave

Nel pannello di controllo un esempio ti mostrerà qual è il punto da cliccare, con un'immagine e una
descrizione che ti permetteranno di capire dove è necessario posizionare il punto.

Clicca sulla posizione corrispondente nella tua foto.

Se tieni premuto il pulsante del mouse quando clicchi l'immagine, vedrai apparire una croce, che potrai
posizionare semplicemente trascinando il mouse.

La croce presenta una piccola etichetta di testo per ricordarti quale punto stai posizionando. Se non la
desideri, l'etichetta può essere disattivata nel pannello delle Impostazioni Generali.

Appena il mouse viene rilasciato, Portrait Professional ti chiederà automaticamente di selezionare il prossimo
punto. In ogni caso, se vuoi regolare i punti già posizionati, puoi cliccarli e trascinarli.
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Vista Profilo 

Se il viso è di profilo, seleziona il pulsante Vista di Profilo alla base del pannello di controllo. 

Nel caso tu non sia sicuro se il viso è di profilo o meno, guarda se entrambi gli occhi sono visibili. Se ne vedi
solo uno, dovuto al fatto che la testa è girata, premi il pulsante Vista Profilo.

Una volta premuto, dovrai semplicemente posizionare i punti di un solo occhio, della punta del naso e di una
sola parte della bocca.

2.4 Regola il Contorno

Visualizzazione e posizionamento contorno

Dopo che i punti principali sono stati posizionati , il passo seguente consiste nel regolare i contorni intorno
ai relativi tratti in modo che Portrait Professional conosca in maniera accurata la posizione di ogni punto.

Salta questa fase

Clicca il pulsante "Salta alla fase finale" per saltare il posizionamento dei tratti di contorno viso, occhi e bocca.

Se premi il pulsante 'Salta', verrai direttamente trasportato alla fase finale dove potrai vedere l'immagine
migliorata. Considera che alcuni slider non saranno disponibili.

Se effettui dei cambiamenti  alle posizioni dei contorni, il pulsante 'Salta' non verrà più mostrato.

Dovrai quindi premere il pulsante 'Avanti'.

Nota: se questo pulsante non appare, controllare che l'opzione Mostra 'Passare alla fase finale' sia
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selezionato  sulla finestra delle  Impostazioni Generali.

Inoltre una volta iniziata la fase di cambiamento dei contorni, il pulsante 'Salta ' non verrà mostrato.

Aggiustamento dei contorni

La linea di contorno viene visualizzata come un continuo di linee blu posizionate sull'immagine nella finestra di
lavoro principale. Le linee possono essere spostate trascinando i quadratini.

Ci sono due tipologie di quadratini, entrambi posizionabili cliccandoli e trascinandoli.

I quadrati di colore verde a forma di scatola - sono punti la cui posizione viene regolata
automaticamente, sulla base del posizionamento che hai dato ai punti.

I quadratini blu - sono i punti che hai posizionato. All'inizio, solo i 5 punti che hai posizionato nella fase
precedente sono blu.

Ogni volta che trascini un quadrato verde, questo si trasformerà in un quadratino blu per informarti che si tratta
di un punto che tu hai posizionato.

Poiché la posizione dei quadrati verdi viene automaticamente regolata sulla base dei tuoi posizionamenti dei
quadratini, ogni volta che ne muovi uno le posizioni di alcuni o di tutti i quadrati verdi potrebbe cambiare.

Per ottenere i migliori risultati, cerca di muovere meno punti possibile per allineare il contorno. E
muovi meno possibile anche i punti che intendi spostare. Se passi ore a sistemare i punti
meticolosamente, non solo perdi tempo, ma è anche probabile che tu ottenga risultati peggiori.

Dopo aver regolato la posizione dei quadrati, premi la barra di spazio o clicca sul pulsante Avanti. 

Regolazione contorno tratti

Portrait Professional ti guiderà a turno attraverso ogni singolo tratto del soggetto in modo che tu possa
verificare e, dove necessario, regolare il posizionamento del contorno selezionato per ogni lineamento.

Ti basterà spendere solo qualche secondo in questa fase, in quanto Portrait Professional non ha bisogno che
le posizioni siano definite in modo particolarmente accurato. In genere, meno spostamenti fai, migliore è il
risultato.
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Una volta completato il passaggio attraverso tutti i tratti, premi ancora il pulsante Avanti per fare in modo che
Portrait Professional inizi ad elaborare la tua immagine. Questo ti porterà alla fase successiva, quella del 
Ritocco Immagine , dove inizia il divertimento!

I Tratti

I tratti del viso vengono visualizzati nel seguente ordine. 

Occhio e sopracciglio sinistro

La coda dell'occhio sinistro è nella posizione che hai selezionato nella fase precedente, quella di 
posizionamento dei lineamenti principali .

Magari vuoi regolarne la posizione più nel dettaglio ora che l'immagine è ravvicinata, così come quella degli
altri punti intorno all'occhio.

Due cerchi blu sono mostrati all'interno dell'occhio. Quello più piccolo dovrebbe circoscrivere la pupilla (la
parte nera al centro dell'occhio). Mentre il cerchio più grande dovrebbe combaciare con l'iride (la parte
colorata). Entrambe i cerchi vengono posizionati automaticamente, in questo modo di solito non avrai
necessità di regolarli. Nel caso in cui il posizionamento non fosse corretto, aspetta che il contorno dell'occhio
venga impostato, prima eventualmente di intervenire, poiché le posizioni dei cerchi potrebbero risultare
corrette una volta che il contorno dell'occhio si trova nella giusta posizione.

Se hai bisogno di muovere i cerchi, clicca sul punto al centro di ognuno. Questo ti permetterà di riposizionarli.

Se clicchi sul punto al centro dell'occhio, appariranno altri due punti, uno per ogni cerchio. Questi punti ti
permettono di regolare la dimensione dei cerchi in modo che si allineino rispettivamente al contorno della
pupilla e dell'iride. Le posizioni di questi punti intorno al cerchio non sono importanti, in quanto servono solo
ad impostarne le dimensioni.

A volte la forma del sopracciglio può rendere difficile il posizionamento della relativa linea di contorno. In questi
casi è bene non preoccuparsene troppo e posizionare la linea in modo approssimativamente corretto. Anche
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ammesso che si riuscisse a sistemare con cura la linea attorno al sopracciglio, ma ciò richiedesse un
movimento eccessivo dei punti, si potrebbe ottenere un miglior risultato muovendoli meno e avendo il
contorno del sopracciglio in posizione grosso modo corretta.

Occhio e sopracciglio destro

Le considerazioni fatte a riguardo dell'occhio e del sopracciglio sinistro sono valide anche per l'occhio ed il
sopracciglio destro.

Naso e Bocca

Quando arrivi in questa fase, apparirà il pannello Bocca Aperta o Chiusa?, ammesso che non sia stato
disattivato nelle Impostazioni Generali . Questo pannello presenta due pulsanti:

Bocca Aperta

Premi questo pulsante se la bocca del viso che stai migliorando è aperta. Vedrai quindi quattro linee tra gli
angoli della bocca. Le due in alto dovrebbero essere posizionate intorno al labbro superiore, mentre le due in
basso intorno al labbro inferiore. Se la linea inferiore del labbro superiore viene avvicinata fino a combaciare
con quella superiore del labbro inferiore, la prima sparirà per lasciare solamente il punto di controllo al centro.
A questo punto la bocca verrà considerata chiusa.

Bocca Chiusa 

Premi questo pulsante se la bocca è chiusa. Vedrai quindi tre linee tra gli angoli della bocca. La linea al centro
dovrebbe essere posizionata lungo la linea dove si incontrano le labbra.

Se sei abituato a premere la barra di spazio per passare velocemente alla fase successiva, nota
che puoi anche usarla per chiudere la finestra di dialogo che chiede se la bocca è aperta o
chiusa. Se questo avviene, la bocca verrà considerata come aperta. Nel caso in cui questa sia in
realtà chiusa, puoi sia premere il pulsante Indietro e poi premere Avanti per far apparire di nuovo
il pannello, oppure puoi semplicemente unire le due linee centrali. 

Contorno Viso

Il contorno del viso non ha bisogno di essere tracciato in modo accurato. Così come per le altre parti, anche in
questo caso otterrai migliori risultati se muovi il meno possibile solo i punti strettamente necessari.

Cerca di evitare di muovere i punti attorno al viso. Muovili solo per avvicinarli o allontanarli da esso.

2.5 Migliora l'Immagine

Dopo aver giustapposto la linea perimetrale attorno al viso nell'immagine, puoi iniziare il miglioramento.

Visualizzazione risultato

Puoi scegliere se visualizzare l'immagine prima e dopo, una accanto all'altra, oppure se visualizzare solo
l'immagine migliorata su larga scala. Usa le etichette sopra le immagini per selezionare l'opzione che
preferisci.

Qualsiasi opzione usi, per controllare le modifiche puoi sempre passare dall'immagine migliorata ("dopo") a
quella originale, tenendo premuto il tasto Invio.
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Modifica risultato

Portrait Professional migliorerà la tua immagine automaticamente nel momento in cui raggiungi questa fase.
Guarda Slider Salvati  per capire come configuare questa impostazione di miglioramento predefinita.

Puoi modificare quanto un'immagine viene migliorata muovendo gli slider nel Pannello di Controllo .

Gli slider sono raccolti in sezioni, che controllano vari aspetti del viso. Quando entri per la prima volta in questa
fase, le sezioni Controlli Modellamento Viso  e Controlli Pelle  sono aperte, al contrario delle altre che
invece rimangono chiuse. Le sezioni possono essere aperte o chiuse premendo il pulsante sulla relativa
barra di intestazione. Questa ha un piccolo triangolo accanto, che guarda giù se la sezione è aperta, o a destra
se è chiusa.

Prova a muovere lo slider Principale in ogni sezione per avere un'idea generale dell'effetto gestito da quella
sezione.

Gli slider secondari (più in basso) in ogni gruppo, ti permettono di avere un controllo più dettagliato sull'effetto.

Portrait Professional è dotato a sua volta di una serie di modelli di Slider Salvati , che includono valori
predefiniti degli slider per ottenere un particolare effetto. Puoi passarli in rassegna per vedere quanti tipi di
miglioramento sono possibili per la tua foto.

Risoluzione problemi

La maggior parte dei problemi che si manifestano sulle immagini migliorate sono causati o da uno o più
slider gestiti esageratamente, o dall'errata regolazione delle aree della pelle e dei capelli.

Usa i Pennelli  per sistemare le aree della pelle e dei capelli.

Salvataggio risultati

Per salvare i risultati, seleziona il comando Salva dal Menu File  o dal pulsante Avanti in alto a sinistra. 

Questo ti permette di salvare l'immagine migliorata come file JPEG. L'opzione Salva Jpg/Tiff permette extra
opzioni di salvataggio per i file JPEG, ed anche il salvataggio di file TIFF.

Nel caso in cui volessi salvare tutte le impostazioni in modo da poter riaprire in seguito l'immagine e
continuare a regolare gli slider, seleziona il comando Salva Sessione dal Menu File. Verranno così salvate
l'immagine originale, tutte le posizioni dei punti, le aree di pelle e capelli e tutti i valori degli slider in un file
proprio del programma, con estensione ".pp".

2.6 Foto di Gruppo

Lavorare su foto di gruppo

Se è presente più di un viso nella tua immagine, devi semplicemente completare tutto il processo di
miglioramento su un viso alla volta.

Inizia col posizionare i punti dei tratti su un viso, e poi passa per tutte le altre fasi finché il risultato non ti
soddisfa.

Dopodiché puoi ripetere lo stesso processo per ogni viso nell'immagine.

Per tornare all'inizio del processo e migliorare un altro viso, puoi

Selezionare il comando File > Migliora Un Altro Viso In Questa Foto, oppure
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Premere il pulsante Avanti  e selezionare Migliora Un Altro Viso In Questa Foto dal menu a discesa.

Puoi ripetere questo processo quante volte vuoi finché ogni viso nella foto non è stato migliorato.

IMPORTANTE: Nota per favore che quando selezioni questo comando le modifiche per migliorare il viso
selezionato sono gia' fissate. Non sarai perciò più in grado di modificare il modo in cui il viso è stato
migliorato.

Di conseguenza è bene che ti accerti di essere completamente soddisfatto con ogni viso modificato  prima di
passare a quello successivo.

2.7 Modalità Plug-in

Solo per Edizione Studio

L'edizione Studio di Portrait Professional può entrare in "modalità plug-in". Questa è progettata per l'uso di
Portrait Professional quando questo viene lanciato da un altro programma per migliorare un'immagine che il
programma sta gestendo. In questo modo Portrait Professional si comporta come un plug-in del programma.

Quando Portrait Professional è in modalità plug-in, si verificano i seguenti cambiamenti:

Il solo comando nel Menu File  è Salva e Chiudi. Questo perché una volta che l'immagine è stata
migliorata in Portrait Professional, tutto ciò che devi fare è salvare sull'immagine originale e chiudere
Portrait Professional. Operazione che ti riporterà a lavorare sull'altro programma. 

Lo strumento Ritaglio non è disponibile in modalità plug-in, in quanto l'altra applicazione in genere si
aspetterà che l'immagine abbia lo stessa dimensione dopo essere stata migliorata con Portrait
Professional. 

Esempi di applicazioni per cui Portrait Professional funziona come plug-in sono Adobe Photoshop, quando si
usa il Portrait Professional Photoshop plug-in , e Adobe Lightroom, quando Portrait Professional è stato
impostato come editore opzionale esterno. 

2.7.1 Migliora Tutto il Corpo

Portrait Professional è progettato soprattutto per migliorare i ritratti.

Ad ogni modo, se la tua foto include anche altre parti del corpo, è possibile utilizzare gli strumenti di
miglioramento anche sulle altre parti di pelle visibili.

Tutto quello che devi fare è assicurarti che Portrait Professional individui quali parti della foto  riconoscere
come pelle. Operazione eseguibile usando gli strumenti area pelle, come descritto su Impostazioni Area Pelle

.
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3 Riferimento

Questa sezione ti fornisce informazioni sui differenti comandi e controlli di menu in Portrait Professional.

Il Riferimento Menu Comandi descrive ogni comando del menu.

Il Riferimento Pannello Controlli  descrive ognuno dei controlli disponibili nella  fase di  ritocco immagine
.

Il Riferimento Finestre di Dialogo  descrive le principali finestre di dialogo usate nell'applicazione.

3.1 Riferimento Menu Comandi

Questi sono i comandi disponibili sulla barra di menu di Portrait Professional.

Menu File Comandi per aprire, salvare, stampare i file o modificare le impostazioni.

Menu Modifica Annulla e Ripristina.

Menu Corpo Intero Contiene un unico comando, Modifica Area Selezione Pelle.

Menu Visualizza Comandi per controllare la visualizzazione dell'immagine.

Menu Aiuto Comandi per inviare una richiesta di aiuto, controllare gli aggiornamenti, ricevere
assistenza o visualizzare informazioni riguardo al programma.

3.1.1 Menu File

Il menu File comprende i seguenti comandi:

Apri... Apre un file (vedi Tipologie di File Supportate ).

Se un file con modifiche non salvate è già aperto, ti verrà suggerito di salvare o
annullare le modifiche prima dell'apertura di un nuovo file.

Apri Gruppo... Solo per Edizione Studio  

Apre la finestra di dialogo Gruppo .

Salva e Apri Successivo Solo per Edizione Studio

Questo comando appare solo quando si lavora con un'immagine aperta dalla
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finestra di dialogo Gruppo .

Salva l'immagine corrente e apre la successiva nel gruppo. 

La cartella in cui viene salvato il file e il formato del file, sono impostati dalla
finestra di dialogo Gruppo .

Questo comando potrebbe apparire come "Apri Successivo" se un'immagine è
aperta dal gruppo e poi chiusa usando il comando File > Chiudi. 

Salva Salva il file corrente. Quando questo comando viene usato per la prima volta
dopo l'apertura di un file, le seguenti regole vengono applicate:

Se hai aperto un file JPEG, l'immagine migliorata sarà salvata come JPEG.

Se hai aperto un file TIFF o qualsiasi tipo di file RAW (Solo per Edizione Studio)
l'immagine migliorata sarà salvata come TIFF.

Se hai aperto un file di sessione (estensione .pp), il file di sessione verrà
salvato.

D'ora in avanti, questo comando salverà lo stesso tipo di file come è stato
salvato in precedenza.

Se questo comando è usato per la prima volta ed un nuovo file è stato creato,
apparirà un pannello Salva File per permetterti di scegliere dove salvare il file. 

Questo comando è disponibile solo nella fase di miglioramento immagine .

Salva Come... Salva il file corrente. Si comporta in modo simile al comando Salva, tranne per il
fatto che il pannello Salva File è sempre in vista per permetterti di scegliere dove
salvare il file.

Questo comando è disponibile solo nella fase di miglioramento immagine .

Salva Jpg/Tiff... Attiva il pannello Opzioni Salvataggio Immagine  per permetterti di  salvare
l'immagine migliorata come file JPEG o TIFF, e per impostare le opzioni salvate.

Una finestra di dialogo Salva File apparirà per permetterti di selezionare dove
salvare il file.

Questo comando è disponibile solo in fase di miglioramento immagine .

Salva Sessione Salva la sessione corrente in modo che potrà essere di nuovo aperta su Portrait
Professional.

I file di sessione Portrait Professional vengono salvati in un formato peculiare
che non può essere caricato da altre applicazioni. L'estensione del file è ".pp". Il
formato include sia l'immagine che tutte le posizioni dei punti, le impostazioni
degli slider e le maschere.

Questo comando è disponibile solo in fase di miglioramento immagine .

Chiudi Chiude la sessione corrente. In caso ci siano modifiche non salvate, ti verrà
suggerito di salvarle o annullarle.
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Il comando Chiudi ti riporta alla schermata iniziale di Benvenuto .

Migliora Un Altro Viso In
Questa Foto

Riporta l'applicazione alla fase iniziale in modo che un altro viso nella stessa
immagine possa essere migliorato.

Lo stesso comando è disponibile sul Pulsante Avanti .

Guarda Foto di Gruppo  per maggiori informazioni a riguardo.

Questo comando è disponibile solo in fase di miglioramento immagine .

Impostazioni... Attiva la finestra di dialogo Impostazioni .

Stampa... Attiva la finestra di dialogo Stampa, che ti permette di stampare l'immagine
migliorata.

Esci Chiude l'applicazione. In caso ci siano modifiche non salvate, ti verrà suggerito di
salvarle o annullarle.

Modalità Plug-in

Se l'applicazione è in modalità plug-in , l'unico comando nel menu File è Salva e Continua, il quale  salva
sopra l'immagine originale per poi chiudere l'applicazione.

3.1.2 Menu Modifica

Il menu Modifica comprende i seguenti comandi:

Annulla Annulla le modifiche ai valori degli slider e quelle effettuate dai pennelli.

Questo significa poter sperimentare con differenti impostazioni salvate, o provare a
muovere qualsivoglia slider in totale sicurezza, poiche' sarà sempre possibile tornare
allo stadio precedente le modifiche se queste non sono ritenute soddisfacenti.

Questo comando è disponibile solo nella fase di miglioramento immagine .

Ripristina Ti permette di ripristinare l'effetto di un'azione che era stato annullato con il comando 
Annulla.

3.1.3 Menu Corpo Intero

Il menu Corpo Intero presenta il seguente comando:

Modifica Area Selezione Pelle... Questo comando attiva il pannello Selezione Pelle  per modificare
l'area di pelle selezionata.

Questo comando è disponibile solo nella fase di miglioramento
immagine .
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3.1.4 Menu Visualizza

Il menu Visualizza include i seguenti comandi:

Schermo Interno Adatta l'applicazione a tutto lo schermo, in modo da massimizzare l'area di lavoro.

Per riportare l'applicazione allo stato di finestra, seleziona di nuovo questo
comando.

Renderizzazione
Rapida

Aumenta la velocità di elaborazione dell'immagine.

Questo avviene riducendo il numero di pixels di lavoro nell'immagine migliorata.

Questa opzione è utile nel caso in cui gli slider siano particolarmente lenti sul tuo
computer.

Se l'immagine ritoccata ti sembra troppo sfocata, allora è preferibile che disattivi
quest'opzione.

N.B. Questa opzione si applica esclusivamente alla modalità di visualizzazione
dell'immagine all'interno del programma. La qualità del file salvato (File > Salva
Jpg/Tiff) non viene modificata.

3.1.5 Menu Aiuto

Il menu Aiuto comprende i seguenti comandi:

Contenuti Avvia l'aiuto online, mostrando la tavola dei contenuti.

Guida di Avvio Rapido Avvia l'aiuto online, mostrando la Guida Avvio Rapido .

Abbreviazioni Tastiera Avvia l'aiuto online, mostrando le Abbreviazioni Tastiera .

Riabilita Pop-up di Aiuto Attiva tutti i messaggi pop-up di aiuto che sono stati disabilitati. Questo
comando appare solamente se hai disattivato i messaggi pop-up di
aiuto.

Controlla Aggiornamenti... Avvia il  browser predefinito per mostrarti se hai o meno la versione più
recente di Portrait Professional.

Se sono presenti aggiornamenti disponibili, ti verranno forniti i relativi link
per scaricarli.

Supporto... Avvia il web browser predefinito per mostrarti le pagine di supporto di
Portrait Professional.

Puoi utilizzarlo per trovare risposte alle domande più comuni, o per
contattare il team di assistenza di Portrait Professional
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Informazioni su Portrait
Professional

Attiva il Pannello Informazioni, che mostra la versione di Portrait
Professional in tuo possesso.

3.2 Riferimento Pannello di Controllo

Questa sezione descrive i controlli principali disponibili nella fase di miglioramento dell'immagine.

Panoramica Controlli Miglioramento Immagine

Indietro e Avanti - Permette di tornare alle fasi precedenti o passare alle successive

Zoom  - Permette di selezionare l'area dell'immagine che viene visualizzata

Slider Salvati  - Permette di impostare gruppi di slider su valori salvati

Controlli Slider  - Sono i comandi principali degli slider e permettono di avere la completa padronanza sul
modo in cui l'immagine viene migliorata

Questi comandi sono raccolti nei seguenti gruppi:

Controlli Modellamento Viso  - Permettono di gestire come viene modellato il viso

Controlli Pelle  - Permettono di gestire come vengono migliorata la pelle

Controlli Occhi  - Permettono di gestire come vengono migliorati gli occhi

Controlli Bocca e Naso  - Permettono di gestire come viene migliorati la bocca, le labbra e il naso

Controlli Capelli  - Permettono di gestire come vengono migliorati i capelli
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Controlli Luminosità Pelle  - Permettono di regolare la  quantità di luce sulla pelle

Controlli Immagine  - Controlli che influiscono su tutta l'immagine, come luminosità/contrasto e
ritaglio 

Foto Originale - Mostra l'immagine ("Prima") originale

Foto Migliorata - Mostra l'immagine ("Dopo") migliorata

Visualizzazione Controlli

Le principali sezioni nel pannello dei controlli (in alto sulla destra) possono essere aperte o chiuse cliccando
sui pulsanti a capo di ognuna. Questi pulsanti hanno al fianco un piccolo triangolo che punta verso il basso
quando la sezione è aperta, o verso destra quando è chiusa.

Ridimensionamento Controlli

Il pannello dei controlli può essere allargato o ristretto muovendo il bordo destro del pannello stesso.

A loro volta, i gruppi principali all'interno del pannello possono essere ridimensionati muovendo lo spazio tra
essi.

Posizionamento e spostamento controlli

Il pannello può essere spostato (e reso così finestra indipendente) cliccando due volte sulla barra di
intestazione.

Una volta tolto dalla posizione di base, può essere mosso liberamente sullo schermo.

Può in seguito essere riposizionato cliccando di nuovo due volte sulla barra di intestazione, o trascinandolo
sul bordo destro o sinistro della schermata principale.

Quando si trascina il pannello per riposizionarlo, nota che non è sufficiente spostare la finestra dei controlli sul
bordo destro o su quello sinistro della schermata principale, in quanto è il cursore che deve essere spostato
vicino ai bordi.

Visualizzazione immagine migliorata

Per impostazione predefinita, quando il software viene installato per la prima volta, l'immagine originale e
quella migliorata vengono mostrate una di fianco all'altra, come appare nella schermata qui sopra.

Le due etichette sopra le immagini determinano l'impaginazione della finestra di lavoro.

Clicca sull'etichetta Visualizza Solo Dopo per avere sullo schermo solo l'immagine migliorata.

Clicca sull'etichetta Visualizza Prima e Dopo per ritornare all'impaginazione con le immagini a confronto.

Alternare tra l'immagine originale e quella migliorata

Qualsiasi impaginazione tu abbia scelto, hai sempre la possibilità di prememere il tasto invio per passare
velocemente dalla visualizzazione dell'immagine migliorata a quella dell'immagine originale. L'immagine
originale viene mostrata  finché il tasto invio rimane premuto.

Ciò ti permette di passare dalla foto migliorata a quella originale, il ché è un ottimo modo per osservarne i
cambiamenti.

In alternativa, puoi tenere premuto il mouse sul pulsante sopra l'immagine, che dice Tieni premuto questo
pulsante (o il tasto invio) per visualizzare l'altra immagine.
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3.2.1 Torna Indietro

I pulsanti indietro e Avanti sono in cima al pannello dei controlli, a sinistra del testo che mostra la fase di
lavoro corrente.

Il pulsante indietro ti riporta alle fasi di lavoro precedenti, quello avanti passa alle successive e appare quando
è possibile farlo. 

Cliccare una volta sul pulsante Indietro ti riporterà di un passo indietro. Subito alla destra del pulsante c'è un
altro pulsante con una freccia verso il basso. Premilo e si aprirà un menu a tendina che mostra tutte le fasi
precedenti a cui è possibile tornare. 

L'immagine qui sopra mostra il menu a discesa che appare quando si preme indietro in fase di finalizzazione
del miglioramento della foto.

Quando il pulsante indietro viene premuto durante altre fasi, vengono mostrati solo gli stadi precedenti a
quello corrente.

Il motivo principale del ritorno alle fasi precedenti è la correzione della posizione dei punti. Ad esempio, se trovi
che il miglioramento di un tratto, come il viso o la bocca, non stia funzionando bene, puoi tornare indietro e
verificare che la relativa linea di contorno sia posizionata correttamente. 

Comandi Menu Indietro

Indietro a Regola Contorno Ritorna alla fase in cui puoi sistemare la linea di contorno.

Questa funzione appare solo nella fase di miglioramento
della foto.

Indietro a Posizionamento Caratteristiche Ritorna alla fase di individuazione dei lineamenti principali.

Questo comando appare solo quando hai superato questa
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fase.

Se ritorni alla fase di posizionamento dei lineamenti, dovrai
ripassare anche per la fase di regolazione della linea di
contorno.

Indietro a Selezione Genere Ritorna alla fase in cui viene selezionato il genere del viso.

Questo comando appare solo quando hai superato questa
fase.

Se ritorni alla fase di selezione genere, dovrai ripassare
anche per le fasi di posizionamento dei tratti e di regolazione
della linea di contorno.

Indietro ad Apri Un'Altra Foto Riporta l'applicazione alla fase iniziale. Questa operazione
equivale a selezionare Apri dal menu File.

Migliora Un Altro Viso In Questa Foto Questo comando è separato dagli altri da una linea, in
quanto funziona in modo differente.

Questo comando sostituisce di fatto l'immagine originale con
quella migliorata, dopodiché ritorna alla fase di selezione
genere.

Questo ti permette di affrontare di nuovo il processo per
migliorare un altro viso nella stessa foto.

Guarda Foto di Gruppo  per maggiori informazioni.

Comandi Menu Avanti

Il pulsante Avanti ti porta alle fasi successive finché non raggiungi la fase di Miglioramento Immagine .

In questa fase, premere il pulsante Avanti farà apparire un menu a tendina con utili comandi. Questi sono gli
stessi del comando corrispondente nel menu File .

Salva Salva il file corrente. 

Salva Come Attiva il pannello Salva File che ti permette di selezionare
dove salvare il file corrente, ma non di cambiare la tipologia
di file. Se vuoi cambiarla, usa i comandi Salva Jpg/Tiff o
Salva Sessione.

Salva Jpg/Tiff Apre il pannello Opzioni Salva Immagine ,che ti  permette
di salvare l'immagine migliorata come JPG o TIFF, ed
impostare le opzioni di salvataggio.

Salva Sessione Salva la sessione corrente così da poter essere
successivamente riaperta in Portrait Professional.
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Migliora Un Altro Viso In Questa Foto Riporta l'applicazione alla fase iniziale del processo così che
un altro viso nella stessa immagine possa essere
migliorato. 

3.2.2 Controllo Zoom

Il Controllo Zoom è parte del pannello dei controlli nella fase di miglioramento della foto.

Permette di vedere quale area dell'immagine è visibile nella finestra di lavoro. Inoltre è provvisto di controlli che
ti permettono di allargare o restringere il campo visivo, o fare una panoramica della visualizzazione corrente.

La foto qui sopra mostra il Controllo Zoom.

L'intestazione Controllo Zoom comprende i seguenti comandi:

Pulsante Zoom Permette di riavvolgere il menu controllo Zoom in modo che solo l'Intestazione sia
visibile.

Cliccalo di nuovo per riaprire il menu controllo Zoom.

Slider Zoom Permette di avvicinare (scorrimento verso destra) o allontanare (scorrimento verso
sinistra).

 Pulsante "Adatta" Adatta la schermata in modo che tutta l'immagine sia visibile.

 Pulsante "Viso" Adatta la schermata solo sul viso. 
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Pulsante "1:1" Configura la scala di zoom in modo che un pixel dell'immagine originale equivalga
ad uno dello schermo.

Pulsante Avvicina/
Allontana

Mostra un menu a tendina con una scala di rapporti di zoom possibili.

Il rapporto di zoom corrente è marcato con un segno.

I rapporti definiscono la relazione tra i pixel dell'immagine originale e quelli dello
schermo, come mostrato nei seguenti esempi:

4:1 significa che 4 pixel dello schermo sono riempiti da 1 pixel dell'immagine
(l'immagine è allargata con un fattore di 4).

1:4 significa che 1 pixel dello schermo è coperto da 4 pixel dell'immagine
(l'immagine è ristretta con un fattore di 4).

Il riquadro di selezione nel Controllo Zoom può essere trascinato per effettuare manualmente una panoramica
dell'immagine.

Cliccare fuori dal rettangolo centrerà la visualizzazione sul punto cliccato.

Si può fare una panoramica e scorrere la visualizzazione manualmente anche selezionando lo strumento 
Scorrimento Manuale .

Ridimensionamento Controllo Zoom

L'intero pannello di controllo (incluso il Controllo Zoom) può essere allargato trascinandone il bordo destro.

Il Controllo Zoom può essere allungato o accorciato trascinando lo spazio tra il Controllo Zoom e il Controllo
Slider Salvati.

Abbreviazioni Tastiera

+ Avvicina.

- Allontana.

3.2.3 Slider Salvati

La funzione Slider Salvati ti permette di impostare velocemente i valori di più slider.

Premi un pulsante nel pannello di controllo Slider Salvati per impostare gli slider in modo che diano l'effetto
descritto dal proprio nome.
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Quando Portrait Professional viene installato, è già fornito di una serie di Slider Salvati pronti per l'uso.

Una delle impostazioni degli Slider Salvati è utilizzata per definire i valori iniziali degli slider quando un viso
viene migliorato. L'impostazione usata può variare a seconda che il viso sia maschile o femminile, ed è
indicata dal simbolo maschile o femminile come mostrato nella figura qui sopra. Per modificare quale
impostazione Slider Salvati è configurata come predefinita per i nuovi visi, usa la finestra di dialogo Gestione
Slider Salvati .

L'Intestazione Slider Salvati comprende i seguenti controlli:

Pulsante Slider Salvati Ti permette di richiudere il controllo Slider Salvati in modo tale che rimanga
visualizzata solo l'intestazione. Una volta chiuso, i controlli nella barra di
Intestazione Slider Salvati cambieranno in quelli descritti sotto.

Clicca di nuovo per estendere il controllo Slider Salvati.

"Pulsante Slider Salvati" Apre la finestra di dialogo Salva Slider . Questa ti permette di salvare i
valori correnti degli slider come una nuova impostazione Slider Salvati.

"Pulsante Gestione" Apre la finestra di dialogo Gestione Slider Salvati . Questa ti permette di
rinominare, riposizionare o cancellare gli Slider Salvati. Inoltre, ti consente
di modificare gli Slider Salvati come predefiniti maschili o femminili.

"Pulsante Aiuto" Apre la pagina di aiuto.

Nota: ogni impostazione di Slider Salvati non coinvolge necessariamente tutti gli slider. Questo significa che
se selezioni un'impostazione di Slider Salvati, e poi un'altra, e poi riselezioni la prima, non riporterai
necessariamente tutti gli slider agli stessi valori che avevano dopo avere selezionato la prima impostazione la
prima volta. Ciò accade perché ogni slider condizionato dalla seconda impostazione, ma non dalla prima, non
sarà riportato indietro.

64

62

64



Riferimento 37

© 2011 Anthropics Technology Ltd.

Il controllo Slider Salvati chiuso

Quando il controllo Slider Salvati viene chiuso premendo il Pulsante Slider Salvati, ha questo aspetto:

Il Pulsante Slider Salvati e il Pulsante Gestione sono sostituiti da un Pulsante Selezione Slider Salvati, che ti
permette di selezionare un'impostazione di Slider Salvati anche se il controllo è stato chiuso.

Quando premi sul Pulsante Selezione Slider Salvati, apparirà un menu a discesa contenente tutti gli Slider
Salvati. Clicca su uno di questi per configurare gli slider sui valori di quell'impostazione.

Ridimensionare il controllo Slider Salvati

L'intero pannello di controllo (incluso il controllo Slider Salvati) può essere ingrandito trascinandone il bordo
destro.

Il controllo Slider Salvati può essere allungato o accorciato trascinando lo spazio tra gli Slider Salvati e il
Controllo Principale degli slider.

3.2.4 Controlli Slider

Gli Slider costituiscono il modo principale attraverso cui gestire il miglioramento di un'immagine.

La maggior parte degli slider sono regolati per colori (come mostrato sopra), dove il verde indica i valori
normali, il rosso i valori alti, e l'arancio i valori intermedi. 

Sezioni di Slider

Gli slider sono organizzati in un certo numero di sezioni.

Controlli Modellamento Viso Rimodella finemente il viso per abbellirne i lineamenti.

Controlli Pelle Migliora l'aspetto della pelle.

Include anche strumenti per la rifinitura di aree che Portrait Professional
considera come pelle.

Controlli Occhi Migliora l'aspetto degli occhi.

Include anche un'opzione per abilitare la rimozione occhi-rossi.

Controlli Bocca e Naso Migliora l'aspetto della bocca e naso.

Controlli Capelli Migliora l'aspetto dei capelli.

Include anche strumenti per la rifinitura di aree che Portrait Professional
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considera come capelli.

Controlli Luminosità Pelle Migliora l'illuminazione sulla pelle.

Controlli Immagine Controlla vari aspetti dell'immagine complessiva, come la luminosità e
il contrasto.

Include anche uno strumento che permette di ritagliare l'immagine.

Per prevenire confusione sullo schermo, ogni sezione può essere aperta o chiusa cliccando sul suo titolo. La
freccia accanto al titolo punta a destra quando la sezione è chiusa, mentre punta in basso quando è aperta.

Ogni sezione può inoltre essere attivata o disattivata premendo il pulsante attivo/disattivo alla destra del nome
della sezione. Quando una sezione è disattivata, non ha effetto sull'immagine. Questo può essere utile per
vedere quale effetto viene determinato da una particolare sezione.

Organizzazione Slider

Gli slider seguono un'organizzazione gerarchica.

Ogni sezione ha uno Slider Principale che controlla tutti gli altri slider nella sezione stessa. Questo ti permette
di vedere come i controlli in quella sezione influiscono sull'immagine.

Al di sotto di ogni slider principale c'è una gerarchia di slider per il controllo fine sul miglioramento.

Se uno slider ha più sub-slider dipendenti, allora l'etichetta dello slider verrà visualizzata come un pulsante
con un triangolo sulla sinistra del titolo. Premi questo pulsante per aprire i sub-slider.

Quando muovi uno slider che comprende dei sub-slider, anche questi si muoveranno di conseguenza.

Quando muovi un sub-slider, vedrai muoversi anche lo slider di riferimento, ma ad un'ampiezza minore.
Questo perché lo slider di riferimento mostra sempre una media bilanciata degli slider da lui dipendenti. In
questo modo fornisce un'indicazione generale dei valori dei sui sub-slider anche quando questi sono chiusi.

Usare gli Slider

Ogni slider controlla gli effetti descritti dalla sua etichetta.

Per la maggior parte degli slider, l'effetto aumenta se lo slider viene mosso verso destra, mentre diminuisce
se viene mosso verso sinistra. Fanno eccezione que gli slider che ammettono valori negativi e hanno il valore
di 0 al centro. In questo caso, occorre allontanare lo slider dal centro per aumentare l'effetto o riavvicinarlo al
centro per diminuirlo .

A seconda di come trascini uno slider, puoi vedere quale sia il suo effetto, in quanto l'immagine viene
aggiornata in tempo reale.

Se lo slider è a 0, allora l'effetto che controlla non apporterà alcun cambiamento all'immagine.

Gli slider con valore 0 al centro tendono a "scattare" verso 0, cioe' ad assumere valore 0 ogni volta che
vengono posizionati nelle sue vicinanze. Se vuoi posizionare lo slider su un valore vicino a 0, tieni premuto il
tasto CTRL per evitare che "scatti" automaticamente sullo 0. 

Puoi anche cambiare la posizione dello slider non trascinandolo ma cliccando sul suo valore numerico ed
usando il controllo su/giù, oppure digitando direttamente il valore.

Per capire qual è la funzione propria di ogni singolo slider, passaci sopra con il mouse.
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3.2.5 Controlli Modellamento Viso

Portrait Professional è l'unico software di ritocco fotografico che ti dà la capacità di rimodellare finemente ed
abbellire i lineamenti del viso, con il semplice movimento degli slider. 

Alcuni  ritengono che questa peculiare funzione di Portrait Professional, di modificare cioè la forma del viso,
sia inappropriata o eccessiva per il miglioramento di una foto. Si può decidere di lasciare gli slider al valore di
0. In questo modo Portrait Professional non intaccherà la fisionomia del soggetto. 

Ad ogni modo, prima di escludere questo effetto considerandolo una "finzione", ti invitiamo a provarlo - rimarrai
impressionato/a da come a volte anche una sottile definizione dei tratti può portare ad un sostanziale
miglioramento del soggetto. Il consiglio che ti diamo è quello di intervenire solo leggermente - giusto quanto
basta per dare al viso un aspetto più asciutto o come se fosse stato fotografato in una giornata
particolarmente favorevole.

Slider

Fronte Migliora la forma del capo.

Mandibola Regola la forma della mandibola.

Naso Migliora la forma del naso. Clicca il pulsante Naso per accedere
ai relativi sub-slider:

Accorcia Naso         Accorcia (o allunga) il naso modificando la
dimensione della testa.

Prolabio    Accorcia (o allunga) il prolabio, la striscia di pelle che
va dal labbro superiore all'attaccatura del naso, modificando la
lunghezza di quest'ultimo.

Punta Sottile            Restringe (o allarga) la punta del naso.

Naso Sottile              Restringe (o allarga) l'intero naso.

Collo Snello Snellisce il collo.

Occhi Modifica contemporaneamente la posizione e la forma di occhi e
sopracciglia. Clicca il pulsante Occhi per accedere ai relativi
sub-slider:

Grandezza Occhi   Allarga (o rimpicciolisce) gli occhi del
soggetto. Clicca sul pulsante Grandezza Occhi per accedere ai
due sub-slider che ti permettono di intervenire su un solo occhio
alla volta.

Occhio Sinistro       Migliora la forma dell'occhio sinistro (utile
per pareggiarne forma e dimensione).

Occhio Destro         Migliora la forma dell'occhio destro.

Strabismo                 Allontana (o avvicina) gli occhi.

Forma sopracciglia  Migliora la forma delle sopracciglie. Clicca
sul pulsante Forma sopracciglia per accedere ai due sub-slider
che ti permettono di intervenire su una sola sopracciglia alla
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volta.

    Forma Bocca Migliora la conformazione complessiva della bocca. Premi il
pulsante Forma Bocca per accedere ai relativi sub-slider:

    Labbro Superiore Migliora la forma del labbro superiore.

    Labbro Inferiore Migliora la forma del labbro inferiore.

    Espressione Cambia l'espressione della bocca.

    Linea Labbra Attenua la linea tra i denti e le labbra per prevenire un effetto
seghettato che potrebe verificarsi in fase di modellamento del
viso. Questo sub-slider non appare quando la bocca del
soggetto è chiusa.

Esagera                                              Versione estrema del modellamento viso.        Funziona solo se usato
insieme ad altri slider che modificano la forma del viso.  

Esempio

  

3.2.6 Controlli Pelle

Portrait Professional ti permette di rimuovere o ridurre nel dettaglio rughe, macchie e altre imperfezioni,
sempre mantendo l'originale consistenza della pelle. Tutto questo può essere fatto con il semplice movimento
degli slider. 

Puoi anche ridurre luci e ombre sottili, regolare il bilanciamento, la tonalità e la tonalità del viso.
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Portrait Professional riconosce automaticamente l'area da trattare come pelle, ma puoi ottenere risultati più
accurati controllando e sistemando l'area pelle.

Slider

Imperfezioni Rimuove finemente arrossature e riduce piccoli accumuli nell'area di
pelle.

          Prima                      Dopo

Rughe De-enfatizza le rughe nell'area di pelle rendendole più lievi e fini.

          Prima                      Dopo

Sfumature Fine Dissolve macchie scure e rughe leggere nell'area di pelle.  

Prima    Dopo

Pori Rimuove i pori e addolcisce l'area di pelle donandole un effetto morbido.
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Prima    Dopo

Pelle Rimuove maggiori imperfezioni dalla pelle senza perdere i dettagli.

Prima    Dopo

Tonalità Dona una maggiore omogeneità di colore all'area di pelle.

Prima    Dopo

Riflessi Riduce i riflessi luminosi nell'area di pelle.

Prima    Dopo

Colorito Pelle Modifica la tonalità generale del colore nell'area di pelle rendendola più
calda (più rossa) o più fredda (più blu).

Pattern In fase di correzione della pelle, gestisce quanto tessuto viene aggiunto. Il
ché avviene principalmente mediante le pennellate. Ingrandisci
l'immagine per vedere i cambiamenti apportati al tessuto della pelle.
Premi il pulsante Tessuto per accere ai relativi sub-slider:

 Luminosità Regola, con accuratezza, la luminosita' del tessuto.

 Saturazione Regola, con accuratezza, la saturazione del tessuto.

 Dimensione Allarga o restringe l'area pelle.
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Abbronzatura Conferisce all'area pelle un aspetto abbronzato. Clicca sul pulsante
Abbronzatura per accedere ai relativi sub-slider:

Satura   Dona all'area di pelle un colore più intenso.

Scurisci   Scurisce finemente l'area di pelle.

   

   Controllo Sfumatura Rimuove le macchie della pelle evitando che le zone di tessuto più scuro
stingano sulle zone chiare.

 

Tipologie pattern. Sono disponibili diversi pattern tra cui selezionare.

Rimozione Macchie

Per impostazione di base, Portrait Professional rimuove automaticamente le macchie.

Ciò che tu puoi fare è regolare il grado della rimozione utilizzando il menu a tendina Rimozione Macchie, posto
in cima ai Controlli Pelle.

Se pensi che Portrait Professional non abbia rimosso la macchia, puoi ritoccare manualmente l'area in
questione usando il pennello Ritocco.

Se Portrait Professional ha rimosso una macchia che in realtà volevi mantenere, puoi ripristinarla
manualmente usando il pennello Ripristino.

Maggiori informazioni sull'uso dei pennelli .

Impostazione Area Pelle

Portrait Professional determina automaticamente quali aree dell'immagine sono considerabili come pelle.

Per vedere l'area che Portrait Professional sta considerando come pelle, clicca sul pulsante Visualizza/
Modifica Area Pelle sotto i Pennelli Area Pelle dei Controlli Pelle. L'area della pelle verrà così visualizzata
come una patina di colore blu sopra l'immagine. Questa verrà automaticamente selezionata se premi il
pennello Aumenta o quello Riduci.
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Se l'area non è posizionata in modo corretto, potrai regolarla manualmente usando i Pennelli Area Pelle.

Usa il pennello Espandi per intervenire su aree che sono pelle, ma che Portrait Professional non sta
considerando come tali.

Usa il pennello Riduci per intervenire su aree che non sono pelle, ma che Portrait Professional sta
considerando come tali.

Maggiori informazioni sull'uso dei pennelli .

Puoi anche fare in modo che Portrait Professional ricalcoli l'area della pelle cliccando sul pulsante Visualizza/
Modifica Area Pelle. Questo aprirà la finestra di dialogo Selezione Pelle .

Esempio

Le immagini sottostanti di Prima e Dopo mostrano un esempio di come Portrait Professional rimuova
automaticamente le rughe:
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3.2.7 Controlli Occhi

Portrait Professional può automaticamente ravvivare, sbiancare e definire gli occhi. I controlli Occhi ti
permettono di regolare con esattezza gli effetti desiderati, compreso il cambiamento del colore.

Slider

Occhi Bianchi Sbianca la parte bianca degli occhi. L'area sulla quale viene applicato l'effetto è definita
dallo slider Area Occhi.

Lo sbiancamento rimuove ogni colore dal bianco degli occhi lasciando un'ombreggiatura
di grigio quando lo slider è al massimo.  Clicca sul pulsante Sbiancamento Occhi per
accedere ai due sub-slider che ti permettono di intervenire su un occhio alla volta.

Bianco Occhi Illumina la parte bianca degli occhi, aumentandone la brillantezza senza perderne il
colore.   Clicca sul pulsante Brillantezza Occhi per accedere ai due sub-slider che ti
permettono di intervenire su un occhio alla volta.

Area Sclera Regola l'area dell'occhio che sarà sbiancata o illuminata dagli slider Sbiancamento
Occhi o Luminosità Occhi. Clicca sul pulsante Area Sclera per accedere ai due sub-
slider che ti permettono di regolare l'area di ciascun occhio separatamente.

Definizione
Occhi 

 Regola la definizione degli occhi.

 Clicca sul pulsante Definizione Occhi per accere ai relativi sub-slider, che ti permettono
di regolare la definizione delle varie parti dell'occhio:
  

 Ciglia Superiori Sx           Definisce le ciglia superiori dell'occhio sinistro.

 Ciglia Inferiori Sx             Definisce le ciglia inferiori dell'occhio sinistro.

 Occhio Sinistro                Definisce l'occhio sinistro.

 Area Ciglia Sinistro         Regola l'area sulla quale vengono applicati gli effetti di

Definizione Occhi per l'occhio sinistro.

 Ciglia Superiore Dx        Definisce le ciglia superiori dell'occhio destro.

 Ciglia Inferiore Dx          Definisce le ciglia inferiori dell'occhio destro.

 Occhio Destro                Definisce l'occhio destro.

 Area Ciglia Destro         Regola l'area sulla quale vengono applicati gli effetti di

Definizione Occhi per l'occhio destro.   

Definizione
Sopracciglia

 Regola la definizione delle sopracciglia. Clicca sul pulsante Definizione Sopracciglia
per accere ai due sub-slider che ti permettono di intervenire su un sopracciglio alla volta.

Luminosità Iride Illumina o scurisce l'iride (l'area colorata dell'occhio). Clicca sul pulsante Luminosità
Iride per accere ai relativi sub-slider che ti permettono di intervenire su un occhio alla
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volta.

Colore Iride
Occhi

Attiva i controlli per modificare il colore degli occhi. Clicca sul pulsante Colore Iride
Occhi per accedere ai relativi sub-slider, che ti permettono di modificare il colore delle
iridi:

Quantità del Sfumatura 

Quando lo slider è a 0, il colore degli occhi resta invariato (gli slider Colore e Intensità
sono disattivati).

Quando lo slider è a 100, il colore degli occhio è definito per intero dagli slider Colore e
Intensità. Per valori inferiori a 100, il colore degli occhi è definito in parte dal colore 
originale e in parte dagli slider Colore e Intensità.

Se lo slider si trova a 0 e uno degli slider Colore o Intensità viene attivato, il valore dello
slider passa automaticamente a 100.

Clicca sul pulsante Quantità del sfumatura per accere ai relativi sub-slider che ti
permettono di intervenire su un occhio alla volta.

Colore    Definisce il colore dell'occhio (quando lo slider Quantità del cambiamento ha un
valore diverso da 0). Clicca sul pulsante Colore per accere ai relativi sub-slider che ti
permettono di intervenire su un occhio alla volta.

Intensità    Definisce l'intensità del colore degli occhi. Clicca sul pulsante Intensità per
accere ai relativi sub-slider che ti permettono di intervenire su un occhio alla volta.

Se hai modificato il colore degli occhi usando questi controlli, puoi selezionare la
casella Colore Occhi Originale per riportare gli occhi al loro colore originario. Quando
questa casella è attiva, gli slider di Saturazione e Tonalità del colore degli occhi vengono
ignorati. 

Scurimento
Pupille

Scurisce le pupille (l'area nera al centro dell'occhio). Clicca sul pulsante Scurimento
Pupille per accere ai relativi sub-slider che ti permettono di intervenire su un occhio alla
volta.

Riflesso Pupille Rimuove riflessi di luce dalle pupille. Clicca sul pulsante Riflesso Pupille per accere ai
relativi sub-slider che ti permettono di intervenire su un occhio alla volta.

Area
Scurimento 

Aumenta la dimensione dell'area di pupille sulla quale vengono applicati gli effetti degli
slider Scurimento Pupille e Riflesso Pupilla. Piu' la pupilla viene ingrandita, più l'iride si
rimpicciolisce, e quindi l'effetto degli slider applicati all'area iride vengono modificati.
Clicca sul pulsante Area Scurimento per accere ai relativi sub-slider che ti permettono di
intervenire su un occhio alla volta.

Rimozione Occhi Rossi

Se nella tua foto appaiono gli "occhi rossi" (a causa dei riflessi del flash), questi possono essere rimossi
automaticamente selezionando la casella Rimozione Occhi Rossi in cima ai controlli Occhi.
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Aggiungi Riflesso

Puoi selezionare tra una serie di riflessi di luce da aggiungere agli occhi. 

Esempio

Le immagini Prima e Dopo qui sotto mostrano come gli occhi del soggetto siano stati sbiancati e definiti in
modo automatico da Portrait Professional.

  

3.2.8 Controlli Bocca e Naso

Portrait Professional sbianca i denti e migliora il colore delle labbra automaticamente. I controlli Bocca e Naso
ti permettono di regolare con precisione questi effetti per avere esattamente il look che desideri.

Slider

Sbiancamento Denti Questo slider sbianca i denti. L'area di influenza è controllata dallo slider
Sbiancamento Area. Questo controllo non viene visualizzato se la bocca è
chiusa.

Brillantezza Denti Questo slider ravviva la luminosità dei denti. L'area di influenza è controllata
dallo slider Sbiancamento Area. Questo controllo non viene visualizzato se
la bocca è chiusa.

Area Denti Bianchi Modifica l'area influenzata dagli Slider di Sbiancamento e Luminosità Denti.
Questo controllo non viene visualizzato se la bocca è chiusa.

Saturazione Labbra Rende le labbra più colorite.

Scurimento Labbra Muovere questo slider verso destra per scurire le labbra, o verso sinistra
per schiarirle.

Contrasto Labbra Aumenta il contrasto nell'area labbra, dando alle stesse un impatto
maggiore.

Tonalità Labbra Modifica il colore delle labbra.

Definizione Bocca Definisce il contorno e i dettagli della bocca. Clicca sul pulsante 
Definizione Bocca per accedere ai sub-slider che ti permettono di regolare
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la definizione delle varie parti della bocca:

Labbro Superiore Definisce solo il labbro superiore.

Linea Labbra Definisce solo i denti.

Labbro Inferiore Definisce solo il labbro inferiore.

Contrasto Narici Definisce il contorno e i particolari del naso.

Esempio

  

3.2.9 Controlli Capelli

Portrait Professional ti permette di migliorare i capelli del soggetto, semplicemente muovendo gli slider. Nota
per favore che prima di fare ciò, è molto importante che l'area dei capelli sia impostata in modo corretto –
guarda Area Capelli più sotto.

Slider

Luminosità Aumenta o diminiscuisce la luminosita' dei capelli.

Tinta Rende i capelli più chiari o più scuri.

Saturazione Modifica il colore dei capelli. Valori alti aumentano la componente rossa, valori
bassi aumentano la componente grigia.

Intensità Regola l'intensita' del colore dei capelli. 

Modalità Acconciatura Capelli

Ulteriori comandi si trovano nella Modalità Acconciatura Capelli. Clicca su Vai a Modalità Acconciatura Capelli
per accedere agli slider.

Riempimento Ombre
Capelli

Riempie le aree scure tra i capelli (causate da un ammassamento degli
stessi) per un effetto più omogeneo.
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          Prima                        Dopo

Clicca sul pulsante Riempimento Ombre Capelli per accedere ai relativi  sub-
slider, che ti permettono di regolare con accuratezza il riempimento:

Luminosità Ombra Controlla il grado di luminosità delle ombre schiarite dallo slider 
Riempimento Ombre Capelli.

Trama Ombra Controlla il grado di consistenza delle ombre schiarite dallo slider 
Riempimento Ombre Capelli.

Capelli Morbidi Liscia i capelli arruffati. 

 
          Prima                        Dopo

Clicca sul pulsante Capelli Morbidi per accedere ai relativi  sub-slider, che ti
permettono di regolare con accuratezza l'addolcimento:

Grado di Morbidezza Modifica il grado con cui lo slider di Capelli Morbidi rende i capelli più o meno
morbidi.

Premi il pulsante OK per uscire dalla Modalità Acconciatura Capelli.

3.2.10 Controlli Luminosità Pelle

Portrait Professional permette di migliorare la luminosità del viso del soggetto attraverso semplici controlli.
Puoi sistemare i riflessi, le ombre e il contrasto.

Slider

Ombre Riduce le zone scure nell'area di pelle selezionata.

Luce Corregge un'illuminazione non ottimale solo sul viso.

Contrasto Regola il contrasto dell'illuminazione sulla pelle selezionata.
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Riflessi Scurisce le zone luminose nell'area di pelle selezionata.

Nota: gli slider della luminosità influenzano solamente le parti dell'immagine che si trovano nell'area pelle .

Esempio

  

3.2.11 Controlli Immagine

Questi controlli agiscono sull'intera immagine e ti permettono di verificarne l'aspetto generale, attraverso la
gestione di comandi come il contrasto e la tonalità del colore.

Puoi anche ritagliare l'immagine usando lo strumento Ritaglia .
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Slider

Esposizione Regola l'esposizione generale (luminosità) dell'intera immagine.

Contrasto Regola il contrasto generale su tutta l'immagine. Muovi lo slider  sulla sinistra
per dare un effetto più piatto, o sulla destra per avere maggiore risalto.

Ombre Riempie le ombre di luce.

Intensità Regola la vitalità dell'intera immagine. Aumentare la vitalità renderà il colore
nell'immagine più intenso.

Saturazione Regola la saturazione (intensità del colore) dell'intera immagine. 

Tonalità Regola la tonalità (del colore) di tutta l'immagine.

Esempio

  

3.2.12 Strumenti Area Pelle

Portrait Professional identifica automaticamente le aree della fotografia in cui è presente della pelle.  Gli effetti
degli slider Pelle e Luminosita' Pelle vengono applicati su quest'area. In alcuni casi può capitare che
l'identificazione non sia del tutto corretta, per cui è consigliato controllare di persona ed apportare le eventuali
modifiche necessarie prima di iniziare il lavoro su quest'area.   

Puoi visualizzare e modificare l'area pelle dalla sezione Controlli Pelle (clicca su Mostra Controlli Pelle per
accedervi) o dalla sezione Controlli Luminosità Pelle (clicca su Mostra Controlli Luminosità Pelle per
accedervi).
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Clicca quindi il pulsante Visualizza/Modifica Area Pelle (sopra l'elenco degli slider) per accedere agli
strumenti di selezione dell'area pelle. L'area identificata come pelle viene visualizzata con una patina
traslucida color blu. Se hai problemi a visualizzare la fotografia sottostante puoi cambiare il colore della patina
usando il menu a tendina.

Puoi modificare a mano l'area pelle usando i Pennelli Area Pelle . 

In alternativa, Portrait Professional può ricalcolare l'area pelle in maniera automatica. Per farlo, clicca su 
Ricalcola Area Pelle (questo apre la finestra Area Pelle). 

Clicca OK per tornare agli slider di controllo.

3.2.13 Strumenti Area Capelli

Portrait Professional identifica automaticamente le aree della fotografia in cui sono presenti capelli.  Gli effetti
dei relativi slider vengono applicati su quest'area. E' importante che l'area capelli sia individuata con
accuratezza per ottenere il massimo dagli slider capelli.

Puoi visualizzare e modificare l'area capelli dalla sezione Controlli Capelli (clicca su Mostra Controlli Capelli
per accedervi).

Clicca quindi il pulsante Visualizza/Modifica Area Capelli (sopra l'elenco degli slider capelli) per accedere agli
strumenti di selezione dell'area capelli. L'area identificata come capelli viene visualizzata con una patina
traslucida color fucsia. Se hai problemi a visualizzare la fotografia sottostante puoi cambiare il colore della
patina usando il menu a tendina.
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Puoi modificare a mano l'area capelli usando i Pennelli Area Capelli .

Premi OK per tornare agli slider di controllo.

3.3 Riferimento Finestre di Dialogo

Questa sezione descrive le finestre di dialogo in Portrait Professional.

Opzioni Salvataggio Immagine Opzioni di salvataggio di un' immagine come file JPEG o TIFF.

Impostazioni Generali Impostazioni che controllano le varie parti di Portrait Professional. 

Configurazione Colori Impostazioni Profili di Colore (Solo per Edizione Studio).

Lingua Impostazioni Lingua Interfaccia Utente (solo per versioni multi-
lingue).

Salva Slider Opzione utilizzata per salvare i valori correnti degli slider.

Gestione Slider Salvati Per gestire le impostazioni degli Slider Salvati (rinomina, riordina o
cancella).
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Selezione Pelle Ti permette di configurare e ricalcolare l'area della pelle.

3.3.1 Opzioni Salva Immagine

Quando salvi un'immagine usando il comando di menu File > Salva Jpg/Tiff, apparirà la finestra di dialogo
Opzioni Salvataggio Immagine.

Questa ti permette di selezionare con quale tipologia di file salvare l'immagine, se come JPEG o TIFF.

Formato JPEG

Se selezioni JPEG, puoi controllare la qualità dell'immagine salvata. Il vantaggio di scegliere un'immagine a
bassa qualità è quello di avere un file di dimensioni ridotte. JPEG è di solito la migliore opzione se non hai
intenzione di effettuare ulteriori modifiche dopo che l'immagine è stata salvata.

Formato TIFF

Salvare un'immagine come TIFF dà come risultato un file più grande rispetto al JPEG. Tuttavia, TIFF registra
l'immagine così com'è, senza mai perdere qualità. Questa è la migliore opzione se intendi riaprire l'immagine
in seguito su altri programmi di ritocco.

Le immagini TIFF possono essere registrate sia come non compresse, sia come compresse con la minima
perdita di informazioni. L'impostazione raccomandata è per il salvataggio compresso. L'unica ragione per non
selezionare la compressione a perdita minima, sarebbe quella di salvarle perché poi si intende riaprire il file
TIFF in un'altra applicazione che non supporta la compressione TIFF (sebbene sia improbabile che i moderni
software non supportino questo formato).

3.3.2 Impostazioni

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi.

Generale Impostazioni Generali.
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Colore Configurazione Colori.

Lingua Impostazioni Lingua.

Plugin Permette di installare il filtro plug-in per Photoshop che a sua volta permette a Portrait
Professional di essere usato come filtro da Photoshop.
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3.3.2.1 Impostazioni Generali

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi.

Impostazioni Salvataggio File

Non Sovrascrivere il File Originale - seleziona questa casella e, quando salverai un'immagine, Portrait
Professional creerà un nome file predefinito differente da quello originale.

Aggiungi Suffisso al Nome File - con l'opzione sovradescritta attiva, il nome file per i file salvati sarà lo stesso
del vecchio con l'aggiunta del testo inserito qui. Di base, il suffisso aggiunto è "_pp" così, per esempio, se un
file chiamato immagine.jpg viene caricato, allora il file salvato predefinito sarà immagine_pp.jpg
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Impostazioni File Recenti

Non Salvare La Lista Di File Recenti Quando L'Applicazione Viene Chiusa - seleziona questa casella e non
verrà salvata nessuna storia di file aperti quando l'applicazione viene chiusa.

Impostazioni Interfaccia Utente

Usa Interfaccia di Stile Nero - seleziona questa casella per usare lo schema di colore scuro, o deselezionala
per uno stile Windows  più convenzionale.

Mostra Esempi Su Schermata Iniziale - seleziona questa casella per vedere le immagini di esempio nella
Schermata di Benvenuto.

Mostra Scritte Accanto Al Cursore - seleziona questa casella e, quando sarai in fase di posizionamento dei
5 punti principali sul viso, il cursore avrà un testo aggiuntivo accanto ai punti, per aiutarti. 

Visualizza finestra Bocca Aperto o Chiusa - seleziona questa casella e, in fase di regolazione dei punti sulla
bocca, Portrait Professional ti chiederà se questa è aperta o chiusa. Nota che anche con quest'opzione attiva,
puoi premere la barra di spazio per confermare che la bocca è aperta e passare alla fase successiva di
spostamento dei punti. Dopo aver fatto ciò, se la bocca è in realtà chiusa, congiungi semplicemente i punti
della labbra perché questi si uniscano a formare una bocca chiusa. 

Mostra opzione "Salta alla fase finale" - seleziona questa casella per far apparire il pulsante "Salta alla fase
finale" durante la fase di regolazione del contorno.

Mostra pulsante "Migliora Solo Pelle": seleziona questa casella per far apparire il pulsante "Migliora Solo
Pelle" nella schermata iniziale di selezione del genere del soggetto.

Mostra Suggerimenti: deseleziona questa casella per disattivare i suggerimenti che appaiono quando passi
con il mouse sopra un comando.

Impostazioni Aggiornamenti

Controllo Aggiornamenti Automatico: quando questa casella è selezionata, Portrait Professional controlla
periodicamente se è disponibile una nuova versione. In caso sia disponibile, un pulsante aggiorna comprare
nella schermata di benvenuto inziale. Clicca sul pulsante per avviare il browser predefinito e avere
informazioni sull'aggiornamento disponibile.

Impostazioni Modalità Plug-in

Modalità Auto Plug-in - [Solo per EdizioneStudio] Se la Modalità Auto Plug-in è impostata, Portrait
Professional entrerà in modalità plug-in nel caso in cui un percorso sia specificato sulla linea di comando
quando l'applicazione viene lanciata.
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3.3.2.2 Configurazione Colori

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi Tabella Colori.

La gestione del colore permette di accertarsi che i colori visualizzati sul proprio monitor siano il più fedeli
possibile a come dovrebbero apparire nella realtà.

In più, permette di configurare quale profilo di colore Portrait Professional usa al suo interno. Operazione che
coinvolge la gamma dei colori, ovvero la varietà di colori che può essere rappresentata.

Per la massima velocità di esecuzione, seleziona l'opzione "Elevata Performance". Questa permetterà a
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Portrait Professional di ottimizzare l'uso dei profili di colore per lo schermo quando è usato interattivamente. A
prescindere da questa impostazione, quando salverai i file verrà usato il tuo profilo di lavoro scelto. 

Puoi anche configurare l'intensità del colore usata da Portrait Professional, ovvero il numero di bit utilizzati per
rappresentare ciascun campione di colore.

Ogni pixel consiste di 3 campioni di colore (rosso, verde e blu), per cui:

8 bit per campione di colore corrispondono a 24 bit per pixel.

16 bit per campione di colore corrispondono a 48 bit per pixel.

Nota: questa finestra di dialogo è disponibile solo per la versione Studio di Portrait Professional. La versione
standard non ha l'opzione di gestione del colore e lavora solo con 8 bit per campione di colore. Può quindi
capitare che, visualizzando le immagini con la versione standard, i colori sullo schermo non siano
estremamente accurati . Essi preservano, comunque, i loro profili di colore:  l'immagine elaborata e salvata
con la versione standard di Portrait Professional mantiene i colori dell'immagine originale, anche se non sono
visualizzabili. Quando si apre l'immagine con un programma che gestisce i colori in maniera diversa, i colori
originari vengono ripristinati.  

La gestione del colore: come funziona

Quando l'opzione di gestione colore è selezionata, Portrait Professional fa in modo che i colori vengano
visualizzati correttamente sullo schermo, cioè che rispettino il profilo di colore specificato sia dall'immagine
che dal monitor. Per ottenere il massimo dalla gestione del colore è consigliato calibrare il monitor invece di
usare il profilo definito dal produttore. 

Immagina, ad esempio, un'immagine salvata con due profili diversi (RGB e Adobe 1998). In questo caso,  i
colori dei due file appariranno un pò diversi quando l'opzione di gestione del colore è deselezionata. Attivando
l'opzione, invece, i colori appariranno uguali. Per essere precisi, i colori appariranno leggermente diversi
anche quando l'opzione di gestione è attiva, poiche' alcuni colori fuori gamma vanno persi durante la creazione
di un file ed esistono errori di arrotondamento generati da diversi tipi di conversioni dei profili di colore nel
momento in cui l'immagine è mostrata. Queste differenze, comunque, sono molto sottili e difficili da notare.

E' buona norma usare il profilo Adobe (1998) quando si lavora con immagini destinate alla stampa e il profilo
RGB quando si manipolano fotografie al computer. In ogni caso è sconsigliato convertire le immagini da un
profilo all'altro (a meno che non sia strettamente necessario). Durante il processo di conversione, infatti, può
capitare che alcuni colori escano dalla gamma e vadano persi (perché, ad esempio, non possono più essere
rappresentati nel nuovo spazio di colore), o che gli errori di arrotondamento producano un mescolarsi di colori
sulle aree della foto a tinte più uniformi.
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3.3.2.3 Impostazioni Lingua

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi scegli Lingua.

Se selezioni l'opzione Automatico, la lingua verrà automaticamente impostata su quella attualmente in uso dal
tuo computer (se supporta quella lingua), altrimenti verrà selezionata la lingua Inglese.

3.3.2.4 Plugin

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi la Tabella Plugin.
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Questa finestra ti permette di installare Portrait Professional come plug-in di Photoshop.

L’opzione di usare Portrait Professional come plug-in di Photoshop ti è stata offerta nel momento in cui hai
installato il programma sul computer. Questa finestra ti permette di rilanciare il plug-in nel caso avessi scelto
di non installare il plug-in fin da subito o se, nel frattempo, hai installato una versione più recente dii
Photoshop.

Il plug-in di installazione identifica automaticamente la versione (o le versioni) di Photoshop presenti sul tuo
computer. Seleziona il riquadro accanto al nome di ciascuna applicazione per la quale vuoi installare Portrait
Professional come plug-in.

Puoi selezionare manualmente il folder nel quale installare il plug-in. Questa opzione è utile se intendi
installarlo su applicazioni diverse da Photoshop  (compatibili con Portrait Professional) o se il folder di
Photoshop  non viene identificato automaticamente.
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Utilizzo di Portrait Professional da Photoshop

Dopo l'installazione, Portrait Professional compare tra i filtri di Photoshop. Nel menu Filtri di Photoshop, clicca
sul sotto-menu Antrophics e, al suo interno, seleziona Portrait Professional.

 Il funzionamento di Portrait Professional è analogo a quello degli altri filtri di Photoshop: il filtro, cioè, viene
applicato sull’area selezionata (o sull’intera immagine in caso non sia stata selezionata un’area specifica) del
livello sul quale si sta lavorando. Quando selezioni il filtro Portrait Professional, l’immagine viene riaperta con
Portrait Professional (che funziona, in questo caso, in modalità plug-in ). Dopo aver elaborato l’immagine,
clicca Salva e Chiudi nel menu File di Portrait Professional. In questo modo Portrait Professional verrà chiuso
e l’immagine, elaborata, verrà trasferita nuovamente a Photoshop.

3.3.3 Salva Slider

Per aprire questa finestra, premi il pulsante Salva Slider nei Controlli Slider Salvati.

Inserisci un nome e, una volta premuto OK, i valori correnti degli slider saranno registrati con gli altri Slider
Salvati.

Se inserisci il nome in un'impostazione Slider Salvati già esistente, questo verrà sostituito.

Di base, tutti i valori degli slider sono salvati. Nel caso tu intenda salvare solo un sottogruppo di slider, premi il
pulsante Seleziona Slider Da Salvare. Questo allargherà la finestra di dialogo come mostrato qui sotto.
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Clicca sulla casella accanto ad ogni slider per passare di volta in volta tra salvato (selezionato) e non salvato
(deselezionato).

Se clicchi sulla casella di uno slider che ha dei sub-slider, tutti questi verrano impostati sullo stesso valore.
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3.3.4 Gestisci Slider Salvati

Per aprire questa finestra di dialogo, premi il pulsante Gestione nei Controlli Slider Salvati  .

Questa finestra di dialogo mostra le impostazioni di tutti gli Slider Salvati, eccetto il preimpostato "Ripristina
Immagine Originale", che non può essere modificato.

Per rinominare le impostazioni di Slider Salvati, fai doppio click sul nome nella lista e poi digita il nuovo nome.

Per ri-ordinare gli Slider Salvati, puoi trascinarli in una nuova posizione nella lista.

Per cancellare le impostazioni di Slider Salvati, clicca su quello che vuoi cancellare per selezionarlo e poi
premi il pulsante Cancella.

Per impostare una certa configurazione di Slider Salvati come predefinita quando lavori su un nuovo viso,
clicca su quella che desideri e poi premi il pulsante Femminile Predefinito o Maschile Predefinito.

3.3.5 Selezione Pelle

Per aprire questa finestra di dialogo, premi il pulsante Modifica Area Pelle alla base della sezione Controlli
Pelle, o seleziona il comando Modifica Area Selezione Pelle dal menu Corpo Intero .
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La casella Mostra Area Pelle ti permette di visualizzare o nascondere l'area della pelle come una patina blu
sopra l'immagine. Questa funzione equivale a quella della casella Mostra Area Pelle nella sezione Controlli
Pelle .

Per ricalcolare l'area della pelle, seleziona una delle opzioni e premi il pulsante Ricalcolo.

Le opzioni controllano quanto a fondo Portrait Professional ricercherà le tonalità di pelle al di sotto del viso.

Un'alternativa per ricalcolare l'area della pelle è utilizzare gli strumenti Aumenta e Riduci nella sezione
Controlli Pelle.

Nota: se ricalcoli l'area della pelle, tutti i cambiamenti fatti in precedenza utilizzando uno qualsiasi degli
strumenti nella sezione Controlli Pelle, verranno persi.

3.3.6 Gruppo

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Apri Gruppo... dal menu comandi.
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Questa finestra di dialogo  ti permette di impostare una lista di file su cui lavorare. Puoi anche impostare le
opzioni di salvataggio da utilizzare quando ogni file viene salvato.

Aggiungere File

Per aggiungere file al gruppo, premi il pulsante Aggiungi File. Questo apre una finestra di dialogo che puoi
usare per selezionare i file da aggiungere.

I file del gruppo sono visibili nella lista in cima alla finestra. 

Usare Lista Gruppo

Quando premi il pulsante OK, le tue modifiche vengono salvate e il primo file che non è stato già completato
nella lista verrà aperto.

Quando hai terminato di migliorare quell'immagine, seleziona il comando Salva e Apri Successivo dal menu
File . Questo salverà il file corrente usando le opzioni selezionate e poi aprirà automaticamente il prossimo
file nella lista.
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Se apri di nuovo la finestra di dialogo Gruppo, vedrai un un'icona accanto al file che hai appena completato. 

Le seguenti icone possono apparire accanto ai file nella lista:

In Attesa - il file sta aspettando di essere eseguito

Completato - il file è stato elaborato e salvato

Fallito - Impossibile aprire il file

Saltato - il file è stato chiuso senza salvare le modifiche

Puoi ripristinare lo status di un file su "In Attesa" cliccando col tasto destro sul file e selezionando Ripristina
Stato dal menu a tendina. 

Una volta completati tutti i file nel gruppo, premi il pulsante Rimuovi Completati per rimuoverli dalla lista. 

I file nel Gruppo e le sue impostazioni vengono salvati quando Portrait Professional viene chiuso, in modo da
poter continuare a lavorare su di essi quando Portrait Professional viene riaperto. 

Riorganizzare i File

I file vengono aperti nell'ordine mostrato in questa lista. Se desideri riordinarli, seleziona uno o più file nella
lista e premi il pulsante Muovi in Alto o Muovi in Basso. 

Puoi anche rimuovere gli oggetti selezionati premendo il pulsante Rimuovi. Nota che in questo caso i file
verranno solamente rimossi dalla lista, non cancellati dal disco. 

Per selezionare più di un file nella lista, tieni premuto il tasto CTRL quando selezioni un altro file. In alternativa,
puoi tenere premuto il tasto SHIFT per aggiungere tutti i file compresi tra quello corrente e quello su cui hai
cliccato. 

Opzioni di Salvataggio

I file vengono salvati nel formato mostrato nella sezione Opzioni Salvataggio. Premi il pulsante Modifica per
aprire una finestra di dialogo che ti permette di cambiarne il formato. 

Se selezioni la casella Salva Anche Sessione, allora anche il file di sessione Portrait Professional
(estensione .pp) verrà salvato. IN questo modo verranno salvati l'immagine, le posizioni dei punti e i valori di
tutti gli slider. In questo modo potrai aprire un file di sessione per continuare a migliorare un'immagine senza
dover posizionare di nuovo i punti sul viso. Il file di sessione verrà salvato nella stessa cartella e con lo stesso
nome dell'immagine migliorata, ma con l'estensione .pp.  

Se l'opzione Salva nella Stessa Cartella del File Originale è selezionata, i file verranno salvati nella stessa
cartella del file originale. Se vuoi salvare le immagini migliorate in una cartella differente, deseleziona la
casella e inserisci un percorso nel campo Percorso Cartella. Puoi premere il pulsante Sfoglia per aprire una
finestra di dialogo che ti permette di selezionare una cartella in cui salvare.

L'immagine migliorata verrà salvata in un file con lo stesso nome del file originale. Se hai specificato un
suffisso da aggiungere alle Impostazioni Salvataggio File , questo verrà a sua volta aggiunto.

3.4 Riferimento Strumenti

Questa sezione descrive gli strumenti disponibili in Portrait Professional.

Questi strumenti diventano accessibili in fase di miglioramento immagine  e funzionano nella schermata
dell'immagine migliorata ("Dopo").
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Quando cambi strumento, cambi di conseguenza cosa accadrà se clicchi sulla schermata dell'immagine
migliorata.

Ogni strumento ha un proprio cursore di una certa forma, in questo modo potrai facilmente controllare quale
strumento viene selezionato.

Scorrimento Manuale Permette di scorrere la visuale sull'immagine. È impostato come predefinito
se nessun altro strumento viene selezionato.

Pennelli Ti permettono di intervenire sull'immagine migliorata per  ritoccare o
ripristinare macchie.

Pennelli di area Ti permettono di intervenire sull'immagine migliorata per rifinire aree di pelle
o capelli.

Ritaglia Permette di ritagliare l'immagine.

3.4.1 Selezione Manuale

Lo strumento di Scorrimento Manuale è disponibile nella fase di Miglioramento Immagine .

Lo Scorrimento Manuale è impostato come strumento predefinito quando nessun altro strumento viene
selezionato.

Per utilizzarlo, clicca sull'icona dello strumento e trascinalo nell'immagine migliorata per selezionare quale
parte dell'immagine rendere visibile.

Lo Scorrimento Manuale può essere usato come alternativa al Controllo Zoom .

Lo Scorrimento Manuale è l'unico strumento che funziona anche sull'immagine originale, se è stata impostata
la schermata a confronto.

3.4.2 Pennelli

I pennelli diventano disponibili nella fase di Miglioramento Immagine . Funzionano come dei pennelli veri:
posiziona il cursore sopra l'area che vuoi "dipingere" e poi, tenendo premuto il tasto sinistro del mouse,
evidenzia l'area da pitturare. 

Ci sono 2 tipi di pennelli. Questa pagina descrive il funzionamento dei pennelli tradizionali, che si usano per
modificare porzioni di pelle e capelli dopo averne migliorato l'aspetto.  I Pennelli di Area, invece, si usano per
definire le aree di pelle e capelli sulle quali applicare gli effetti. 

Esistono 6 differenti tipologie, che lavorano tutte in modo simile.

Pennelli Ritocco e Ripristino

I seguenti pennelli sono accessibili dalla barra sopra la schermata principale di visualizzazione
dell'immagine.

Pennello Ritocco Usalo per correggere punti o macchie sulla pelle che non sono stati
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eliminati automaticamente.

Pennello Ripristino Usalo per ridipingere sulla pelle punti che sono stati rimossi, ma che in
realtà vorresti mantenere.

Pennelli Pelle

I seguenti pennelli sono accessibili dai Controlli Pelle .

Espandi Maschera Pelle Ti permette di incrementare l'area che sarà trattata come pelle durante il
miglioramento.

Usalo per intervenire su aree della foto che risultano essere pelle, ma che
non sono state automaticamente riconosciute come tale.

Riduci Maschera Pelle Ti permette di correggere aree che non dovrebbero essere trattate come
pelle durante il miglioramento.

Usalo per intervenire su aree della foto che non sono pelle, ma che sono
state automaticamente riconosciute come tale.

Pennelli Capelli

I seguenti pennelli sono accessibili dal gruppo Controlli Capelli .

Aumenta Maschera Capelli Ti permette di incrementare l'area che sarà trattata come capelli durante il
miglioramento.

Usalo per intervenire su aree della foto che sono capelli, ma che non
sono state automaticamente riconosciute come tali.

Riduci Maschera Capelli Ti permette di correggere aree che non dovrebbero essere trattate come
capelli durante il miglioramento.

Usalo per intervenire su aree della foto che non sono capelli, ma che
sono state automaticamente riconosciute come tali.

Controlli Pennelli

Per selezionare un pennello, premi il relativo pulsante.

Premi nuovamente il pulsante per deselezionarlo (questo ti riporterà allo Scorrimento Manuale ).

I pennelli agiscono come pennelli veri. Puoi usarli per intervenire su un'area dell'immagine migliorata, sulla
quale verrà applicato l'effetto del relativo pennello.

Per usare un pennello, premi il tasto sinistro del mouse mentre il cursore è sull'immagine migliorata, e poi
muovi il mouse tenendo il tasto premuto. Rilascia per conludere la pennellata. L'area su cui il cursore passa
nel momento in cui compi questa azione è l'area che hai "dipinto". 

Dimensione Pennello

La dimensione del pennello determina quanto grande sarà la sua area di influenza, la cui grandezza è
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osservabile dalla dimensione del cursore a forma di cerchio.

Forza Pennello

La forza del pennello (opacità) controlla quanto intenso sarà l'effetto del segno del pennello. Un'opacità del
valore di 100 significa che ad ogni pennellata sarà applicato l'effetto completo. Per effettuare modifiche
graduali, puoi impostare un livello di opacità inferiore. 

Per esempio, se selezioni un'opacità del valore di 50 quando usi il Pennello di Ritocco, nel momento in cui
interverrai su una macchia verrà applicata solo la metà dell'effetto di completa rimozione della stessa. Se
rilasci il mouse e poi ripassi sopra la macchia, allora anche l'altro 50% verrà rimosso. Ciò ti permette di
calibrare gradualmente la rimozione della macchia, ma senza applicare un effetto totale che potrebbe
condizionare anche l'area circostante.

Quando un pennello viene selezionato, accanto al pulsante appariranno i controlli per definirne la dimensione
e l'intensità.

Pennello Annulla

Quando utilizzi qualsiasi pennello, l'ultima pennellata può essere annullata usando il comando Annulla dal 
Menu Modifica , o premendo Control-Z sulla tastiera. Ulteriori annullamenti elimineranno le pennellate
precedenti e altre azioni che hai eseguito, tornando indietro lungo la storia della sessione corrente. Dopo un
annullamento puoi anche ripristinare per tornare alla fase in cui eri premendo il comando Ripristina dal Menu
Modifica , o Control-Y.

Supporto Tavoletta

Portrait Professional supporta penna e tavoletta. Se le possiedi troverai in genere più facile usarle quando
disegni. Una tavoletta sensibile alla pressione ti garantirà inoltre maggiore controllo quando dipingi le aree. 

3.4.3 Pennelli di Area

I Pennelli di Area sono indispensabili per migliorare un'immagine perche' permettono di definire le aree in cui
si trovano la pelle e i capelli da ritoccare. Portrait Professional individua automaticamente le aree
dell'immagine che contengono pelle e capelli, ma in alcuni casi può capitare che l'identificazione non sia
corretta o soddisfacente. I Pennelli di Area permettono di correggere gli errori e definire in dettaglio l'area di
lavoro.

I Pennelli di Area sono "intelligenti" nel senso che individuano i bordi di ciascuna regione dell'immagine in
maniera automatica.

La posizione del Pennello di Area viene mostrata con due cerchi concentrici. Quando dipingi usando questo
strumento, il cerchio più interno, chiamato "radar", viene colorato normalmente. L'area compresa tra il cerchio
esterno e il radar, invece, viene colorata solo nei punti che hanno un colore simile a quello del radar.
Per colorare una superficie lungo un bordo, ad esempio, è sufficiente posizionare il radar al suo interno: il
Pennello di Area colorera' automaticamente la superficie fino al bordo, senza andare oltre (anche in caso il
cerchio esterno esca dal bordo stesso).

Puoi bloccare la posizione del radar tenendo premuto il tasto ALT (è utile quando dipingi dettagli molto delicati,
come una ciocca di capelli).
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Pennelli di Pelle

Usa i Controlli Pelle per visualizzare o modificare l'area pelle  (clicca su Mostra Controlli Pelle per accedervi,
poi clicca su Visualizza/Modifica Area Pelle)

Espandi Area Pelle Amplia l'area trattata come pelle. 

Passa questo pennello sopra le aree della foto che contengono pelle, ma non
sono state identificate come tali dal rilevatore automatico.

Riduci Area Pelle Riduce l'area trattata come pelle

Passa questo pennello sopra le aree della foto che non contengono pelle, ma
sono state erroneamente identificate come tali dal rilevatore automatico.

Controlli Capelli

Usa i Controlli Capelli per visualizzare e modificare l'area capelli (clicca su Mostra Controlli Capelli per
accedervi, poi clicca su Visualizza/Modifica Area)

Espandi Area Capelli Amplia l'area trattata come capelli. 

Passa questo pennello sopra le aree della foto che contengono capelli, ma non
sono state identificate come tali dal rilevatore automatico.

Riduci Area Capelli Riduce l'area trattata comecapelli.

Passa questo pennello sopra le aree della foto che non contengono capelli, ma
sono state erroneamente identificate come tali dal rilevatore automatico.

3.4.4 Ritaglio

Il comando Ritaglio è disponibile nella fase di Miglioramento Immagine .

Per selezionarlo, premi il relativo pulsante nella sezione Controlli Immagine .

Il comando Ritaglio è usato per inquadrare e definire l'area dell'immagine che si intende utilizzare per il ritratto
finale. Potresti ad esempio usufruirne per eliminare gli elementi non importanti, in modo che l'immagine sia
focalizzata solo sulla persona. Ad ogni modo quando ritagli in realtà non perdi nulla dell'immagine, cambi
solamente l'area visualizzata e puoi sempre tornare indietro per rimodificare l'area di ritaglio se hai
commesso un errore.

Una volta attivato il comando, la griglia di ritaglio apparirà sulla figura.
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Questa griglia mostra la parte della figura che sarà visualizzata, divisa in terzi come riferimento. Regola la
griglia cliccando e tenendo premuto su qualsiasi suo punto e poi trascinala nella posizione desiderata.

Quando la griglia ha assunto l'aspetto voluto, clicca su Applica per effettuare le modifiche. Se vuoi cancellare
le modifiche effettuate, clicca su Annulla.

CONSIGLIO: Fotografi professionisti di solito posizionano gli occhi e la bocca in un ritratto sulle "terze" linee.
Questo per bilanciare e rendere più piacevole la figura.

Puoi anche fissare il rapporto d'aspetto del ritaglio utilizzando la funzione Definizione Formato nel pannello di
controllo ritaglio. Per esempio potresti voler stampare un'immagine in 15x23 cm (questa è una misura
standard di stampa delle fotografie), e in questo modo lavorare in questo rapporto d'aspetto. Per fare ciò,
imposta i valori della Correzione Rapporto d'Aspetto cliccando sui riquadri Per: e Da: ed inserendo il valore di
rapporto che desideri. Una volta concluso, la griglia di ritaglio sarà fissata automaticamente su quel rapporto a
prescindere dalla posizione in cui la si muova.

3.5 Riconoscimenti Parti Terze

Portrait Professional utilizza un numero di librerie di terze parti, che sono elencate in questa sezione. Offriamo i
nostri ringraziamenti agli autori che ci hanno fornito queste preziose risorse.
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dcraw

La lettura di immagini RAW è fornita da dcraw.

Copyright 1997-2009 by Dave Coffin, dcoffin a cybercom o net

tifflib

La lettura e scrittura di immagini TIFF è fornita da libtiff.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that (i) the
above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon
Graphics may not be used in any advertising or publicity relating to the software
without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.  

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY
OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

jpeglib

La lettura e scrittura di immagini JPEG è fornita da jpegtiff.

This software is based in part on the work of the Independent JPEG Group.

This software is copyright (C) 1991-1998, Thomas G. Lane.

zlib

Il supporto per compressione Zlib è fornito da zlib.

(C) 1995-2002 Jean-loup Gailly and Mark Adler

Adobe DNG SDK

La lettura di DNG è fornita Adobe DNG SDK.

Lossless JPEG code adapted from:

Copyright (C) 1991, 1992, Thomas G. Lane.
Part of the Independent JPEG Group's software.

Copyright (c) 1993 Brian C. Smith, 
The Regents of the University of California
All rights reserved.

Copyright (c) 1994 Kongji Huang and Brian C. Smith. 

http://www.cybercom.net/~dcoffin/dcraw/
http://www.libtiff.org/
http://www.ijg.org/
http://www.zlib.net/
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Cornell University
All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation
for any purpose, without fee, and without written agreement is hereby granted,
provided that the above copyright notice and the following two paragraphs appear in
all copies of this software.

IN NO EVENT SHALL CORNELL UNIVERSITY BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE
AND ITS DOCUMENTATION, EVEN IF CORNELL UNIVERSITY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. 

CORNELL UNIVERSITY SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND CORNELL UNIVERSITY HAS NO
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

Copyright © 2006 Adobe Systems Incorporated. All rights reserved.

Adobe is a registered trademark or trademark of Adobe Systems Incorporated in the
United States and/or other countries. Windows is either a registered trademark or a
trademark of Microsoft Corporation in The United States and/or other countries. Mac is
a trademark of Apple Computer, Inc., registered in the United States and other
countries. All trademarks noted herein are the property of their respective owners.

Adobe XMP SDK

Adobe XMP SDK è utilizzato da Adobe DNG SDK

Copyright 2009 Adobe Systems Incorporated and others.  All rights reserved.  The
original version of this source code may be found at http://adobe.com.

lcms library

La gestione del profilo di colore ICC è fornita da lcms.

Little CMS

Copyright (c) 1998-2007 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

http://adobe.com
http://www.littlecms.com/
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3.6 Tipologie di File Supportati

Portrait Professional è in grado di leggere e scrivere le seguenti tipologie di file:

Tipo Estensione Descrizione

JPEG .jpg; .jpeg Tipologia di file compresso che tende a perdere qualità.

TIFF .tif; .tiff Tipologia di file non compresso o che usa una compressione a perdita
minima.

Nota: I File TIFF contenenti immagini a 16 bit per campione di colore (48 bit
per pixel) sono supportati solo nell'Edizione Studio. 

PP .pp Tipo peculiare di file usato solo da Portrait Professional per registrare una
sessione.

Edizione Studio

Portrait Professional Studio supporta anche la lettura dei file RAW delle seguenti macchine fotografiche:

Casa Produttrice Tipo

Canon .crw; .cr2

Fuji .raf

Kodak .tif; .kdc; .dcr

Minolta .mrw

Nikon .nef

Olympus .orf

Pentax .ptx; .pef

Sony .arw; .srf; .sr2

Sigma .x3f

Epson .erf

Mamiya .mef; .mos

Panasonic .raw

Phase One .tif
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Imacon .fff

 

3.7 Abbreviazioni Tastiera

Portrait Professional fornisce le seguenti abbreviazioni per tastiera nelle varie fasi del processo di
elaborazione dell'immagine:

Menu comandi

CTRL+O File > Apri

F4 Solo Edizione Studio

File > Apri Gruppo

CTRL+S File > Salva

CTRL+W File > Chiudi

CTRL+E File > Migliora un altro viso in questa foto

CTRL+Z Edit > Annulla

CTRL+Y Edit > Ripristina

Schermata Iniziale

BARRA DI SPAZIO Attiva la finestra di dialogo Apri File per permetterti di selezionare il file da aprire.

Selezione Genere

f Imposta il viso come femminile, per poi passare alla fase di Posizionamento dei
Lineamenti.

m Imposta il viso come maschile, per poi passare alla fase di Posizionamento dei
Lineamenti.

Posizionamento Lineamenti

Non ci sono abbreviazioni per tastiera.

Regolazione Contorno

BARRA DI SPAZIO Passa al successivo lineamento da posizionare.  

10
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Vai all'ultima fase della regolazione contorno.

Miglioramento Foto

+ Avvicina.

- Allontana.

INVIO
(se tenuto premuto)

Alterna l'immagine migliorata con quella originale.     
 

a Mostra/Nascondi Area Pelle

t Seleziona lo strumento Ritocco.

r Seleziona lo strumento Ripristino.

s Seleziona lo strumento Aumenta Area Pelle.

d Seleziona lo strumento Riduci area Pelle.

h Seleziona lo strumento Aumenta Area Capelli.

j Seleziona lo strumento Riduci Area Capelli.

c Seleziona lo strumento Ritaglio.

[ Riduce il raggio del pennello (quando il pennello è stato selezionato).

] Aumenta il raggio del pennello (quando il pennello è stato selezionato).

0-9 Modifica l'opacità del pennello (quando il pennello è stato selezionato).

BARRA DI SPAZIO
(se tenuta premuta)

Passa momentaneamente allo strumento Scorrimento Manuale (quando un
pennello è selezionato).

SHIFT
(se tenuto premuto)

Passa temporaneamente al pennello opposto (quando un pennello è
selezionato).

ALT

(se tenuto premuto)    Blocca temporaneamente il radar (funziona solo quando è selezionato un Pennello di
Area). Utile per ritoccare piccoli dettagli come una ciocca di capelli.
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